ScorePAD Baseball
for Palm OS
Handbook

Version 5.0
Copyright

All rights reserved. Reproduction, adaptation, or translation of this document is prohibited without prior written permission of ScorePAD Sports, Inc.

ScorePAD and the ScorePAD logo, RosterPAD, MLBSstats, GSP, Game Situation Panel, InstantSTATS, and the ScorePAD Sports logo are trademarks of ScorePAD Sports, Inc. Palm Computing, HotSync, Palm, Palm Desktop, and Palm logo are trademarks of Palm Inc. and its subsidiaries. All other brands and product names are registered trademarks or trademarks of their respective holders.

Disclaimer and Limitation of Liability

ScorePAD Sports, Inc. assumes no responsibility for any damage or loss claims by third parties which result from the use of this Handbook.

ScorePAD Sports, Inc. assumes no responsibility for any damage or loss claims by third parties which result from the use of the software described in this Handbook.

Support

The ScorePAD website http://www.scorepad.com provides a mechanism for users of ScorePAD to:

Obtain answers to frequently asked questions
Send bug reports
Get news of new releases and companion products
Download updates to ScorePAD
Purchase ScorePAD upgrades and companion products

ScorePAD users may also obtain support by sending email to: support@scorepad.com or calling 678-270-4001.
Entering game information ................................................................. 34
The teams .............................................................................................. 34
Game duration ....................................................................................... 34
Other game information ........................................................................ 35
Creating a new game ........................................................................... 35
Erasing the current game ..................................................................... 35
Selecting another game ........................................................................ 36
Deleting current game ......................................................................... 36
Deleting games (ScorePAD Deluxe Only) ............................................ 36
Forfeiting a game .................................................................................. 37
Game parameters .................................................................................. 38
Leagues ................................................................................................. 39
Number of lineup players .................................................................... 39
Game type ............................................................................................. 40
Scheduled innings ............................................................................... 40
Series ID ............................................................................................... 40
Initial count .......................................................................................... 40
Free Form checkbox ........................................................................... 41
DH may be used checkbox ................................................................. 41
Add players to database checkbox ....................................................... 41
Don’t Synchronize checkbox ............................................................... 42
Filling in the ScoreCard ................................................................. 43
The ScoreCard view .............................................................................. 43
Creating the starting lineup ................................................................. 45
Selecting a team’s scorecard ................................................................. 45
Selecting players .................................................................................. 45
Moving players around in the lineup .................................................... 46
Setting defensive positions .................................................................. 47
Creating lineup without RosterPAD data ............................................ 47
Saving the starting lineup ................................................................. 47
The scorecard with complete lineup .................................................... 48
Player substitution ............................................................................... 48
Straight substitution ............................................................................ 48
Double switch substitution .................................................................. 48
Substitution flexibility ......................................................................... 49
Missed substitutions ............................................................................. 49
Making substitutions in the ScoreCardView ....................................... 49
Making substitutions in the LineupView .............................................. 50
Making substitutions in the GSP .......................................................... 50
Adding players that are not part of a RosterPAD Roster .................... 52
The Lineup view .................................................................................. 53
Editing the lineup ................................................................................. 53
Clearing lineups .................................................................................. 54
Swapping teams and players ............................................................... 54
Editing substitutions ............................................................................. 54
Scoring an At-bat .............................................................. 63

Statistics ........................................................................... 79

Ending a Game ..................................................................... 92
Saving the starting lineups ................................................................. 92
Setting the game status to 'Complete' ................................................ 93
Recording the Win, Loss, and Save ....................................................... 93
Marking save opportunity pitchers ...................................................... 94
Locking-in season stats ................................................................... 94
Updating statistics .......................................................................... 95
Using Infrared with ScorePAD ......................................................... 97
Beaming games ................................................................................ 97
Beaming lineups .............................................................................. 98
Reference Section ......................................................................... 100
At-bat result types .......................................................................... 101
Reach Base Types .......................................................................... 101
Out Types - Batter .......................................................................... 101
Out Types - Runner ........................................................................ 102
Advance Runner ............................................................................ 102
Pitch Detail (ScorePAD Deluxe only) ............................................... 103
Pitch Types .................................................................................... 103
Swing Types ................................................................................... 103
Pitch Results .................................................................................. 103
Pitch Speed Range ......................................................................... 103
ScorePAD's MLB Team Abbreviations ............................................. 103
American League .......................................................................... 103
National League .......................................................................... 103
RosterPAD ..................................................................................... 104
Getting Started With RosterPAD Players ........................................ 106
Creating a RosterPAD Player ......................................................... 106
Entering Batting Statistics ............................................................... 107
Editing a RosterPAD Player ........................................................... 108
Deleting a RosterPAD Entry ........................................................... 108
Working with RosterPAD Players .................................................... 109
Looking Up Players ...................................................................... 109
Sorting by Player Name or Team ..................................................... 110
Beaming RosterPAD Players ........................................................... 111
RosterPAD Menu Commands ......................................................... 112
Record Menu .................................................................................. 112
Options Menu ................................................................................ 114
MLB Stats ...................................................................................... 115
Updating Player Statistics .............................................................. 117
Adding teams to the list to update ................................................... 117
Removing teams from the list to update ......................................... 118
MLBStats subscription ................................................................... 118
ScorePAD Desktop ......................................................................... 119
Scorecard View ............................................................................. 124
Loading a game ............................................................................. 124
The Scorecard ............................................................................................... 125
Printing the score sheets ............................................................................. 128
Printed score sheet detail ............................................................................ 128
Printing a box score report ......................................................................... 128
Creating a box score web page ..................................................................... 130
Exporting game statistics ............................................................................ 130
Exporting games for sharing ....................................................................... 130
Importing a ScorePAD game ....................................................................... 131
Editing game parameters ............................................................................. 131
Changing Scorecard View Preferences ....................................................... 133
Editing lineup players ................................................................................. 135
Changing at-bat details ............................................................................... 137
Deleting a game ........................................................................................... 138
Deleting multiple games ............................................................................ 138
Sending games down to the Palm ............................................................... 139
Examining pitching sequences .................................................................. 139
Moving to other views ............................................................................... 140
RosterPAD View .......................................................................................... 141
Adding players ............................................................................................. 142
Changing player info .................................................................................. 143
Sorting players ............................................................................................ 144
Deleting players .......................................................................................... 144
Moving players among leagues ................................................................... 144
Printing players .......................................................................................... 144
Exporting and importing players ............................................................... 145
Using the clipboard with the RosterPAD view .......................................... 145
Stats View .................................................................................................... 147
Loading a team ........................................................................................... 149
Selecting a date range ................................................................................ 149
Displaying RosterPAD statistics ............................................................... 150
Printing stats sheets ................................................................................... 150
Configuring subviews ................................................................................ 150
Copying statistics to the clipboard ............................................................. 152
Exporting statistics ..................................................................................... 153
Changing export settings .......................................................................... 153
Creating Web pages from the Stats view .................................................. 154
Changing Web page specifications ............................................................. 155
ScorePAD Statistics ....................................................................................... 157
Stats subview descriptions ........................................................................ 158
File Formats .................................................................................................. 164
RosterPAD Import/Export file format .......................................................... 164
Game statistics export file format ............................................................... 166
Exported position player statistics ............................................................. 166
Exported pitcher statistics .......................................................................... 168
Frequently Asked Questions ........................................ 170
“How do I setup a 7-inning game instead of the normal 9-innings?” 171
“How do I setup the International Tie-Breaker Rule?” ....................... 171
“In our league, the batters begin each at bat with 1 ball and 1 strike. Can I setup ScorePAD to automatically register that count?” ........... 171
“Will ScorePAD allow a team to bat more than 9 players?” ............... 172
“My team uses a designated hitter. How do I setup the lineup with a DH?” ................................................................................................................ 172
“What is a ‘No Pitch’ and how do I record it?” .................................. 172
“How do I charge a dropped foul error?” ......................................... 172
“How do I switch sides if the team has recorded less than three outs? 173
“How do I skip an at-bat?” ............................................................... 173
“Does ScorePAD handle the softball short fielder and extra hitter positions?” .......................................................................................... 173
Introduction

Congratulations on your selection of ScorePAD Baseball. ScorePAD Baseball is the most comprehensive scorekeeping software system for the Palm Connect Organizers, Handspring Visors and other Palm Computing Platform compatible handheld computers. ScorePAD offers you at-the-park electronic baseball scoring that is actually easier to use than paper.

Text in are only available in the ScorePAD Deluxe.

With ScorePAD you can keep score while gathering and maintaining statistics. Scoring and gathering statistics are one in the same since ScorePAD compiles statistics from each pitch of each at-bat, from each defensive play, and each ball put in play. In addition, ScorePAD’s conduit allows you to move completed games to your personal computer using Windows 98/ME/NT/2000/XP during the Palm’s HotSync process.

ScorePAD functionality

ScorePAD provides:

- Automated scoring on a small handheld computer
- Visual similarity to paper scoring systems
- Automated prompting for more scoring events
- Automatic statistics gathering and calculation
- Windows software for permanent storage, analysis, and printing
- Roster management for players and their season statistics
- Optional Major League Baseball season statistic updates

ScorePAD benefits

ScorePAD offers you the following benefits:

- Using ScorePAD feels natural to the experienced scorer and yet easy to learn for the beginner.

- ScorePAD’s paper-scoresheet-like interface helps keep you in familiar territory while removing most of the complexity of paper.

- ScorePAD gives you the best of both worlds; an interface you already understand and more information than you would ever calculate using paper.
ScorePAD allows you to store team rosters and statistics on your Palm along with games played for an entire season. With ScorePAD and RosterPAD, you can score and keep stats for an entire season right on your Palm - if you choose.

Added features like infrared beaming of games, lineups, and rosters along with laser printing of score sheets, stats, box scores, play-by-plays and spray charts make it difficult to imagine any advantages paper scoring might provide.

ScorePAD Sports hopes that using ScorePAD and RosterPAD adds to your total baseball or softball experience. Regardless of the level of baseball, the process of scoring increases your knowledge and enjoyment of the game.

The Baltimore Orioles Program Scorecard contains the following warning:

**Warning! Be careful. Scoring a ball game can be habit forming. Proceed at your own risk.**

### About This Manual

This manual assumes that you know how to use the Palm OS device. It also assumes that you have a basic knowledge of baseball scoring terminology and procedure. If you have not acquainted yourself with the Palm OS device, Graffiti, menus, shortcuts, HotSync, or other terminology or procedure associated with the Palm OS device, please take time to read the Palm OS Handbook and go through its tutorial.

If you do not understand baseball scoring procedures and terminology, we recommend you obtain a copy of the book *The Joy of Keeping Score* by Paul Dickson. This book contains history and instruction on keeping score while watching a baseball game. You can obtain a copy from most major booksellers.
Installation

Windows software

Whether you install ScorePAD from CD or downloaded the file from www.scorepad.com, the procedure is the same.

The installation takes you through seven dialogs:

- Welcome
- End User License Agreement
- Registration
- Destination Directory
- Installation Progress
- Finish

Welcome and finishes are just cordial status pages. Let’s take a look at the rest.

End User License Agreement (EULA)

Please take time to read this dialog. The EULA details the legal terms and conditions under which ScorePAD Sports, Inc. grants you a license to use the ScorePAD software. You will want to take care not to violate any of these conditions since the criminal and civil penalties for such violations can be costly.

Press the Yes button on this dialog if you agree to abide by the terms and conditions of the EULA. If you disagree, press No. If you press No, the installation will stop. If you press Yes, the installation will continue and you will be legally bound by the terms and conditions of the EULA.

Registration

The registration dialog prompts you to enter your name, company or organization, and the serial number you received with your copy of ScorePAD. You must enter information in all three of these fields. Once you have completed the registration form, you may proceed to the Destination Directory page.
**Destination directory**

The Destination Directory page allows you to select the directory to which the install program will copy ScorePAD. You may change this directory to any directory you prefer. The default directory is as follows:

```
C:\Program Files\ScorePAD Sports\ScorePAD Baseball
```

**Installation progress**

The installation progress dialog shows you the progress of the installation as it continues. In addition to installing ScorePAD's Windows software on your PC, towards the end of the installation you will be asked "On which handheld device do you want to install ScorePAD and RosterPAD?" Choose the palm user by clicking the down arrow. Once you select "next" you will get a message letting you know the HotSync Manager will install ScorePAD and RosterPAD the next time you HotSync your handheld.

**Palmtop software**

In the event that you did not choose a palm user during initial installation here is an alternative way of getting ScorePAD and RosterPAD onto your handheld. The install process will copy the files `ScorePAD.prc` and `RosterPAD.prc` into your Palm OS directory (usually `C:\Palm\Add-on`). You must use the Palm Install Tool to install these PRC files onto your Palm OS device. Complete the following steps to perform the Palm OS install:

1. Run the Palm Install Tool application on your PC under Windows 98/ME/NT 4/2000/XP by selecting **Start > Programs > Palm Desktop > Palm Install Tool**.
2. Press the Add button in the Palm Install Tool.
3. After the **Open** dialog appears, select ScorePAD.prc then hold down the Ctrl key and select RosterPAD.prc.
4. Press the **Open** button. ScorePAD.prc and RosterPAD.prc will appear in file list of the Palm Install Tool main dialog.
5. Press the **Done** button on the **Palm Install Tool** main dialog.
Completing the installation process

To complete the installation process, you must perform a HotSync operation with your Palm device. The HotSync process will install ScorePAD and RosterPAD on your Palm device. To perform a HotSync operation, place your Palm in its cradle and press the HotSync button on the cradle. Since ScorePAD is a relatively large Palm application, it may take several minutes to transfer to the palm.

To verify that the installation process worked, touch the Applications button to the top-left of the Graffiti writing pad on your Palm OS device. You will see RosterPAD and ScorePAD among the applications installed.

Entering your serial number and key code

If you purchased ScorePAD, RosterPAD, and/or MLBStats, you will need to enter your serial number and key code (include dashes) in each of these Palm products. This tells each Palm application that you are a registered user. If you do not enter your serial number and key code, ScorePAD, RosterPAD, and/or MLBStats will give you Evaluation Expiration messages after 30 days.

How to obtain your device ID and key code:
You will need two numbers to generate your Key Code. Your Serial Number that was issued upon the purchase of ScorePAD, and the device ID number that is located on your Palm.

There are two ways to obtain your device ID on your PDA:

If you do not already have ScorePAD on your PDA:
On your PDA in the main menu where you view all of your programs, tap the pull-down menu. Under ‘App’, select ‘Info...’ toward the bottom of the screen tap so the ‘Version’ menu is highlighted. At the top of the screen you will then see information concerning your device, the identification number will be labeled ‘ID:’, and the number will be a series of numbers and letters (ex. 00U7P883D3BX-L).

If you already have ScorePAD installed on your handheld:
Open the ScorePAD program and tap the pull-down menu. Under ‘Options’, select ‘About ScorePAD’, then tap ‘Register’. Your device identification number will be listed in the dialog box.

Once you have both numbers available, you may enter the information in the corresponding fields below:

Do not delay this final step. You might find yourself at the baseball field without your serial number or key code when the expiration message pops up.

**To enter your serial number and key code:**

Select About ScorePAD from the Options menu of the ScoreCard view.
Tap the Register button
Enter you serial number and key code (make sure to include dashes)
Tap OK to close the Register dialog
Tap OK to close the About ScorePAD dialog.
Quick Scoring Guide
Quick-Guide to Scoring a Game

After you have reviewed the manual and understand the basic set-up of ScorePAD, here's a quick step-by-step guide to score your first game.

Game setup

In the Game Setup view, you should complete the following steps: Select Game Setup from the Options menu of the Scorecard view.

1. Enter the abbreviations of the home and visiting teams or use the down arrows to select the teams if they are entered in RosterPAD
2. Set game start date and time
3. Enter field name, weather conditions, and officials' names

Please refer to the Game Parameters section of the ScorePAD handbook for further instructions on game setup.

Creating a new game

ScorePAD will store as many games as your Palm OS device has free memory. You may setup and use the current game to start scoring. If you have already used the current game and wish to create a new game, press the New button or select Create New Game from the Options menu of the Game Setup View. The Game Setup view will clear. ScorePAD will then set the visiting team to Vis and the home team to Hom. You can now enter team abbreviations and begin scoring in the newly created game.

Entering the starting lineup

ScorePAD automatically loads the rosters of the teams you select from the Game Setup View under Parameters and league selection, if the rosters are entered in RosterPAD. In the ScoreCard view you will select the lineups for each team.

To select lineups you must:

1. Select the team - by tapping on the tab at the top of the screen
2. Select a batting order - the roster will pop up on the right of the screen
3. Select a defensive position for each player - if not already selected in RosterPAD
Selecting players for the lineup

To select a player when RosterPAD players have been pre-entered:

1. Touch the batting slot you wish to change.
2. A list box will appear with the names of all players entered for that team. The player list box will show position players first, then pitchers. Each list is in alphabetical order.
3. Touch the name of the player you wish to place.

Once you have selected a player for each slot in the batting order, the lineup is almost complete.

If you have not entered players for the selected team into RosterPAD, the Lineup view will appear whenever you tap a player position.

Setting defensive positions

Finally, you must set the defensive positions of your lineup. ScorePAD makes this task just as easy as setting the lineup. Touch the box to the right of player's name. A list box will appear with all defensive positions recognized by ScorePAD. Tap the correct defense position and you are done. You should have one and only one pitcher per lineup. If no pitcher is selected pitching statistics are credited to Unknown Pitcher.

When you have selected defensive positions for each player, you have completed the starting lineup. You can also set the lineup and defensive positions in the Lineup Wiz and the Lineup View.

Player substitution

As each team substitutes players, you must make changes to your score card to reflect those substitutions. Changes in the lineup take place in two forms: straight and double switch.

Straight substitution

In a straight substitution, one or more players enter the game in the same batting order and defensive positions as the players they replaced.
Double switch substitution

In a double switch, two or more players enter the game in different defensive positions than the players they replaced in the batting order. For example, a coach might bring in a new pitcher and a left fielder. In a double switch he places the left-fielder in the current pitcher’s batting slot and the pitcher in the current left-fielder’s batting slot.

With ScorePAD you can substitute any player for any other player. ScorePAD maintains statistics for all players that participate in a game whether starting or substitutes.

ScorePAD note on batting entire roster:
Some amateur leagues bat more than the standard 9 or 10 (Using a DH). If your league bats the entire roster, but you have numerous defensive switches, try using this method of substitution. For example: A player bats 11th in the order. He starts the game on the bench but is still batting. In the third inning he moves to third base. In the fifth inning he moves to left field. Finally, in the sixth inning he returns to the bench.

1 Set your lineup at the beginning of the game
2 Go to Lineup Wiz. Lineup Wiz will show you what positions you have open and what has already been filled.
3 To select a position for a player, simply tap on the position next to the players name. If they are not currently at a defensive position you can list them as no position which will produce a — next to their name.
4 When it is time to bring in the players from the bench and make other defensive switches, return to the Lineup Wiz and tap the position next to their name.
5 It is usually easiest to move players currently in the game to No Position, then move the players from No Position into the game
6 This will allow you to make defensive switches only. A prompt will ask you if this is a Position Change or a Correction? This is a Position Change.
7 This will give you a clear and correct substitution
Scoring an at-bat

Scoring procedure

In ScorePAD, a game is simply the aggregate of all of its at-bats. ScorePAD at-bats contain:

- Pitcher
- Pitch sequence
- Pitch results
- On-base and/or out reasons
- Base advance reasons and players
- Destination of ball put in play
- Pitch detail

To score an at-bat, follow the steps below:

1. Record balls and strikes by pressing the appropriate buttons
2. Touch either the **Out** or **On Base** buttons
3. Choose the on-base or out type
4. Touch on playing field to show where batter hit ball
5. Touch the **Advance** button to move batter around bases or drag-and-drop runners
6. Touch the **Out** button and reason to show batter out on-base
Recording pitches

Since you will spend a great deal of time watching and recording balls and strikes, we make this operation simple and flexible. Some scorers are used to the routine of looking up for the pitch and looking down to record the pitch (some for several decades.) If you want to maintain that habit you can either touch the one of the five pitch buttons in the GSP view (Ball, Strk, Foul, PO A, N) or use the buttons on the bottom of your PDA to record the pitches. Select button preferences under the Options menu of the GSP view.

Reaching base

When a batter reaches base on a base on balls or a hit, tap the proper on-base button on the left side of the at-bat square.

- BB - Walk or base on balls
- 1B - Single
- 2B - Double
- 3B - Triple
- HR - Home run

For other on-base types, touch the On Base button at the bottom of the GSP view and select the proper on-base result.

Visit the Reference chapter in this manual for a list of on-base results and their reasons. Once you select an on-base result, all pitch buttons disappear and a single Pitches button appears. To view or edit pitch detail, touch the Pitches button.

Advancing base runners

When you select an on-base result, the On Base button disappears and the Advance button appears. After touching the Advance button, select the proper advance reason from the list. Advance reasons such as batter advance will prompt you for more information. If runners are on-base, ScorePAD will prompt you to advance those runners unless the advance of runners on-base is automatic. In the case of a Hit-by-pitch, Walk, Triple, or Home run, base runners are automatically advanced.

You can also move a baserunner through prompts created by ScorePAD. Simply tap on the base the runner now occupies or use the selections below to take care of all baserunners at once or to throw a baserunner out at a specific base.
Drag and drop base advances

While you record the at-bat of current batter (the batter now at the plate,) you can use the Drag-and-Drop runner advance feature.

Drag-and-Drop base advances were designed to allow you to advance runners on base while recording the balls and strikes for the current batter. This function saves you the effort and time of moving from one at-bat to the next every time a runner advances. Drag-and-drop allows you to advance any runner presently on base from the screen of the batter at the plate.

To use Drag and drop, complete the following steps:

1. Touch your pen on any occupied base and drag from that base to the destination base for that runner. The base will highlight when you’ve dragged far enough.

2. Lift your pen. ScorePAD will display a list box of Advance types.

3. Select the appropriate advance type.

You can also touch any occupied base and it will move you to that player's at-bat screen. **ScorePAD note:** This method is not recommended because it is more time consuming and can become confusing.

1. Once you are at the runner's at-bat screen, touch the Advance button.
2. Select the appropriate advance type.
3. ScorePAD will prompt you for the destination base for that runner. Select the destination base.
4. Once you have completed work on that at-bat, touch Home plate and ScorePAD will take you back to the current at-bat.

**Note:** Drag-and-drop runner advances were designed as a convenience. During an at-bat, if a runner steals a base or advances on a wild pitch, passed ball, etc., you can use drag-and-drop.
Recording an out

The GSP view allows you to record outs four ways.

- When you are keeping pitches and record a total of three strikes, the GSP view assumes that the batter struck out.

- Whether a batter has reached base or not, you may touch the Out button at the bottom of the GSP view and select an out result. The out result list also contains Strikeout so you can select Strikeout from the list if you do not wish to touch strike three times.

- You can record outs using Graffiti abbreviations. When using Graffiti to record outs you write the an abbreviation of the out result. For example, writing "63" and the return gesture represents a grounder to shortstop thrown to first for the putout. "F8 return" would be a flyout to center field. (ScorePAD’s preferred method)

- When runners are on base, you may hold your pen on the runner for two seconds. When the list of out on-base out results appears, select the proper out type and record the defensive positions that assisted or performed the putout.

Defensive Positions

Some outs will require that you enter the defensive positions that assisted in or completed the putout. The Defensive Positions dialog will appear when the at-bat needs that information.

The Defensive Positions dialog shows the defensive positions by their position names. To record defensive positions, touch each position that assisted in or completed the putout. As you touch a defensive position button, the position number for the position button you tap appears on the edit line on the bottom-left of this dialog. The Cancel Out button will appear until you enter defensive positions. Once you enter defensive positions, the Cancel Out button will change to Finish Fielders. When you finish entering defensive positions, press Finish Fielders.

If you make a mistake, touch the Undo button to erase that entry entirely including base advances by all runners. If you want to cancel the out after you have entered one or more defensive positions, press the Undo button until Cancel Out reappears. Finally, press the Cancel Out button.
Base running outs

If a runner is out while on base (for example caught stealing or picked off) there is an easy way to record the out while never leaving the GSP view for the current batter.

1. Hold your pen on the shaded base of the baserunner until a list of outs appears.

2. Select the out type for the runner.

You can also touch the base of the base runner or use the navigation buttons described in this chapter to move to the at-bat of a base runner. You can then press the Out button and select an out type for the runner.
Graffiti Guide
Advanced scoring - Graffiti abbreviations

Once you become an official expert baseball scorer (if you are not already), you can use ScorePAD abbreviations to score at-bats. You must use Graffiti to enter these abbreviations. ScorePAD recognizes abbreviations to speed up scoring for those familiar with baseball. Scoring this way feels nearly equal to scoring with paper. As you write the abbreviation with Graffiti, the letters you enter will appear directly below home plate of the GSP view. You must terminate your abbreviation with the down forward slash (the same stroke that you use to begin a new line). Below is a list of Graffiti abbreviations that ScorePAD recognizes.

At-bat result types

Reach Base Types

x = defensive position 1-9

<table>
<thead>
<tr>
<th>Score Card Display</th>
<th>Graffiti Abbrev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base On Balls</td>
<td>BB</td>
</tr>
<tr>
<td>Single</td>
<td>1B</td>
</tr>
<tr>
<td>Double</td>
<td>2B</td>
</tr>
<tr>
<td>Triple</td>
<td>3B</td>
</tr>
<tr>
<td>Home Run</td>
<td>HR</td>
</tr>
<tr>
<td>Hit Batsman</td>
<td>HB</td>
</tr>
<tr>
<td>Fielders Choice</td>
<td>FCxx</td>
</tr>
<tr>
<td>Error</td>
<td>E</td>
</tr>
<tr>
<td>Sacrifice</td>
<td>SAC</td>
</tr>
<tr>
<td>Dropped 3rd Strike</td>
<td>Kd3</td>
</tr>
<tr>
<td>Defensive Interference</td>
<td>DI</td>
</tr>
<tr>
<td>Obstruction</td>
<td>OB</td>
</tr>
<tr>
<td>Sacrifice Fielder's Choice</td>
<td>FC</td>
</tr>
<tr>
<td>Sacrifice Error</td>
<td>E</td>
</tr>
<tr>
<td>Fielder's Choice Error</td>
<td>FC</td>
</tr>
<tr>
<td>Didn't See</td>
<td>??</td>
</tr>
<tr>
<td>Tie-breaker</td>
<td>TB</td>
</tr>
</tbody>
</table>
### Out Types - Batter

\( x = \text{defensive positions 1-9} \)

<table>
<thead>
<tr>
<th>Score Card Display</th>
<th>Graffiti Abbrev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strike Out Kc or Ks</td>
<td>K, KC, or KS</td>
</tr>
<tr>
<td>Ground Out xx</td>
<td>( x \ (x = 1-6) )</td>
</tr>
<tr>
<td>Tag Out Tx</td>
<td>T or Tx</td>
</tr>
<tr>
<td>Line Out Lx</td>
<td>L or Lx</td>
</tr>
<tr>
<td>Fly Out Fx</td>
<td>Fx, or Fx (7-9)</td>
</tr>
<tr>
<td>Pop Out Px</td>
<td>P or Px</td>
</tr>
<tr>
<td>Foul Out fFx</td>
<td>FF or FFX</td>
</tr>
<tr>
<td>Double Play DP</td>
<td>DP or xxx</td>
</tr>
<tr>
<td>Lineout Double Play Lx</td>
<td>LDP</td>
</tr>
<tr>
<td>Reverse Force Double Play DP</td>
<td>RDP</td>
</tr>
<tr>
<td>Triple Play TP</td>
<td>TP or TPxxx</td>
</tr>
<tr>
<td>Infield Fly Rule IF</td>
<td>IF or IFx</td>
</tr>
<tr>
<td>Sacrifice Fly SF</td>
<td>SF or SFx</td>
</tr>
<tr>
<td>Sacrifice Bunt SB</td>
<td>SB</td>
</tr>
<tr>
<td>Bunt Foul 3rd Strike Kb</td>
<td>KBF</td>
</tr>
<tr>
<td>Spectator Interference Is</td>
<td>IS</td>
</tr>
<tr>
<td>Offensive Interference Io</td>
<td>IO</td>
</tr>
<tr>
<td>Illegal Bat IB</td>
<td></td>
</tr>
<tr>
<td>Out of Batter’s Box OBB</td>
<td>OBB</td>
</tr>
<tr>
<td>Basepath Violation BV</td>
<td>BPV</td>
</tr>
<tr>
<td>Didn’t see ??</td>
<td></td>
</tr>
</tbody>
</table>
Graffiti® writing area and surrounding icons

- Tap **Clock** to see the time, set an alarm, change the time and date.
- Tap **Contrast** to improve screen contrast using slider.
- Tap to open the Applications Launcher. All your applications are listed there.
- Tap to see menus in applications that have them.
- When writing Graffiti characters, write letters on the left, numbers on the right.
- Tap **abc** and **123** to display onscreen keyboards. Then tap characters to enter text.
- Tap to open the Calculator.
- Tap to find text in all applications.

---

Tap here to display alphabetic keyboard.

Tap here to display numeric keyboard.

Tap here to display international keyboard.
**Graffiti writing**

The best way to learn is to practice. To take the Graffiti tutorial on your handheld, tap the Graffiti icon in the Applications Launcher.

1. Start the stroke where the heavy dot is. Don’t try to make the dot; just start there.

2. Don’t lift the stylus until you reach the end of the stroke.

Some characters require a preliminary stroke. For example, to write a quotation mark, tap once and then make the Graffiti stroke for '.

**Basic Graffiti characters (there are many more)**

![Graffiti characters](image)

**Tips**

- Characters do not show up in the Graffiti writing area, but on the handheld screen, wherever the blinking cursor is located in the record you’re working on.

- Write Graffiti characters BIG, and write at normal speed.

- Press firmly with the stylus.

- You can see tables displaying all Graffiti characters simply by drawing the pen stroke: starting from the bottom center of the Graffiti writing area, drag the stylus to draw a straight, imaginary line to the top of the screen.
Getting Started
The Structure of ScorePAD

ScorePAD is divided into 4 views:

1. ScoreCard
2. Game Setup
3. Lineup
4. Game Situation Panel (GSP)

Although ScorePAD has many dialogs, alerts, and pop-up screens, these views comprise the major function of ScorePAD. Below is a summary of the function of each of the views.

**ScoreCard**
- Access all other views
- Display game score card for each team
- Display score of game
- Create starting lineup
- Perform player substitution
- Change player defensive positions
- Move players up and down the lineup
- Switch games
- Move to any at-bat of the game
- Set game logistics at the end of the game

**Game Setup**
- Create new games
- Switch games
- Set game teams and parameters
- Record game logistics
- Deleting games

**Lineup**
- Create or change lineup
- Perform player substitution
- Edit player name, number, batting and throwing hand or position
- Edit player substitution
- Charge an error (that doesn't cause a player to reach or advance)
- Undo substitutions
Game Situation Panel (GSP)
- Record the events of each at-bat (balls & strikes, hits, out, etc.)
- Edit all at-bat details
- Navigate between at-bats
- Show previous at-bats for current batter
- Display game situation including score, inning, outs, and runners
- Pop-up game and season statistics for the current pitchers
- Pop-up game and season statistics for the current batter
- Pop-up inning totals
- Pop-up current lineups and 0-fors

Whenever you exit and re-enter ScorePAD, ScorePAD will return you to the view from which you exited.
Starting ScorePAD

When you tap the Palm’s Applications button, your Palm will display an icon for each native and user-installed application. After installing ScorePAD, its icon will appear on this screen. Tap ScorePAD’s icon to start ScorePAD.

When you start ScorePAD for the first time, it will display the ScoreCard view of the game that it creates by default. From this view you can access all other ScorePAD views.

The ScoreCard view of a newly created game
Starting a Game

Select **Game Setup** from the **Options** menu of the ScoreCard view to get to the Game Setup view. To get the menu bar, you must press the Menu button.

---

**Game Setup**

You are now ready to setup the game. The installation process creates a blank game for your convenience. After you have scored a game, you can start a new game by tapping the **New** button. To setup a game you should complete the following steps:

1. Enter the abbreviations of the home and visiting teams
2. Set game start date and time
3. Enter field name, weather conditions, and officials' names
4. Select players in starting lineup for each team
5. Set players' defensive positions

---

*The Game Setup View*
Entering game information

The teams

First, you will need to set the visiting and home teams. Enter the team names using Graffiti. You can use team abbreviation between 1 and 7 characters in length. If you plan to use MLBStats you must use the MLB team abbreviations in the Reference section of this manual. To set the visiting team you simply erase the default text Vis and use the Graffiti writing area to write a valid team name. For example, ATL is the abbreviation that Major League Baseball uses for the Atlanta Braves. Similarly, to set the home team, erase the default text Hom and write the home team’s short name; for example FLA for the Florida Marlins.

If you have already entered team rosters into RosterPAD or downloaded them using MLBStats, you can select the teams you want from the list of RosterPAD teams. ScorePAD will indicate that RosterPAD teams are available for selection by displaying a down arrow next to the Visitor and/or Home titles. To select a team, tap the proper title and select a team from the list.

Game duration

The Game Setup view requires only that you enter the team name abbreviations. However, you can also record the game’s duration. To record the game’s duration, enter the starting time of the game by touching the Start Time field and setting the time. As the game progresses, the Score Card, Game Setup, and GSP views display the game’s duration in hours and minutes. In addition to setting the start time here, when you record the first pitch of the game, ScorePAD gives you the opportunity to set the game clock’s starting time to the time of that pitch.

The End Time field allows you to set the ending time of the game. ScorePAD will prompt you after the last play of the game to set the end time to the time of that play. Once the End Time is set, you cannot add any more at-bats to the game. Set the End Time after the game is complete. The Delay Duration field allows you the set the total hours and minutes of delay in the game.

ScorePAD note: If after setting the End Time you decide to add an at-bat to the game go back into Game Setup and put the game back in progress.
Other game information

You may also use Graffiti to enter the stadium or field, a description of the weather, the official scorer, the condition of the grounds, the number of fans in attendance, and names of up to four officials. Although ScorePAD will save and HotSync all of the information you enter in Game Setup view, Visitor and Home fields are the only required fields in this view. Once you have completed the Game Setup information, touch the Done button to return to the ScoreCard view.

Creating a new game

ScorePAD will store as many games as your Palm OS device has free memory. You may setup and use the current game to start scoring. If you have already used the current game and wish to create a new game, press the New button or select Create New Game from the Options menu of the Game Setup View. The Game Setup view will clear. ScorePAD will then set the visiting team to Vis and the home team to Hom. You can now enter team abbreviations and begin scoring in the newly created game.

ScorePAD note: Typically, a PDA with at least 8 MB of memory can store over 100 games in ScorePAD.

Erasing the current game

When ScorePAD erases a game it removes all of the at-bats and lineups of the game. If you start scoring a game and decide you do not want to keep the at-bats or lineups of that game, you might want to erase it and score another game. To erase an existing game, select Erase Game from the Options menu of the Game Setup view. You will have the choice of erasing only the at-bats of the game or erasing everything including the teams and lineups. Erasing only removes the game information. To totally remove game from your Palm device you must delete the game.

Warning: If you intend to keep any of the information from a game you plan to erase, you must perform a HotSync operation with the ScorePAD Desktop before erasing the game.
Selecting another game

ScorePAD identifies the current game by the number to the left of the title bar. To select another game, touch the number. A list will appear containing the teams and dates of each of the games stored in ScorePAD. Touch the game you want from the list and that game becomes the current game. The ScoreCard view contains the same mechanism for selecting games.

Deleting current game

When ScorePAD deletes a game, it removes all information about that game from your Palm OS device's memory. To delete a game, you must select Delete current game from the Options menu of the Game Setup view. After selecting the menu item, ScorePAD will prompt you to confirm the delete. If you answer Yes, ScorePAD will permanently remove the current game from your Palm device. Only games that have been HotSync'd to your PC can be recovered once deleted from the Palm. ScorePAD will not allow you to delete a game if that game is the only game left in your Palm device. You must have at least one game in your Palm device at all times.

Deleting games (ScorePAD Deluxe Only)

Multiple games can also be deleted at one time. To delete multiple games select Delete games from the Options menu of the Game Setup view. Touch on start date and end date to select the range of games you want deleted. Once the date range is set select OK and the games will be permanently deleted from your PDA. You may also choose to delete an individual team's games by writing in the roster name in the provided space on the Delete games dialog screen.
Forfeiting a game

Forfeit a game allows you to select which team forfeits the game and awards a loss and win appropriately. When you HotSync the game back to your computer it will tally the win or loss in your Stats view on your desktop software. To forfeit a game, you must select Forfeit game from the Options menu of
the **Game Setup** view. After selecting the menu item, ScorePAD will prompt to pick the team that has forfeited. Once you select **Visitor** or **Home** it will confirm who forfeited under **EndTime** in the **Game Setup** view.

**Game parameters**

![Game Parameters Dialog]

The Game Parameters dialog allows you to change the parameters under which a game is played and identified. You can set the following special game parameters:

- Home team league (RosterPAD League)
- Visitors team league (RosterPAD League)
- Number of home team lineup players
- Number of visiting team lineup players
- Game type
- Scheduled innings
- Series ID
- Initial count
- DH may be used checkbox
- Free Form checkbox
- Add players to database checkbox
- Don't HotSync checkbox

To access the Game Parameters dialog, touch the **Parameters** button on the Game Setup view.
Leagues

Leagues in ScorePAD equate to categories in RosterPAD. Since many youth baseball leagues use a common set of team names, RosterPAD employs the use of leagues to distinguish teams. If your child plays in My Park on the Astros and you are playing the Their Park Astros, you might create My Park and Their Park Leagues in RosterPAD and add each player to their respective league. You might also create a league for each age group within a park (i.e. 9-10 My Park) ScorePAD allows you to pick from those leagues on the Game Parameters dialog.

To select a league:

1. Tap the current league name.
2. The list of RosterPAD leagues will appear.
3. Tap the league you wish to assign.

Remember, you can only create leagues, teams, and players RosterPAD. You can create 16 leagues (categories) in RosterPAD. You can create and assign as many players as you have free memory.

Number of lineup players

With some free substitution rules, all of the players on the team become part of the batting order though they may or may not play a defensive position. To accommodate this scenario, ScorePAD allows you to set the number of lineup players for each team (up to 18 per team). Since ScorePAD automatically moves from the current batter to the next logical batter, you must set the exact number of batters on each team.

If you use a Designated Hitter (DH) for one of your defensive players, include his or her position in the number of lineup players and check the DH may be used check box. For example, an MLB team in the National League uses nine players on offense and defense with no DH. In the American League, teams use a DH in to bat for one of the defensive players. In ScorePAD you will set the number of Lineup Players to 9 for National League teams and 10 for American League teams. Additionally, you will check the DH may be used checkbox for American League Teams.

ScorePAD note: If you are in a youth league that allows more than nine players to bat, rather than using DH we recommend that you select none for position for all players that are in the lineup but are not playing defense.
Game type

You can set the game type to any of 16 descriptions. This will allow both the ScorePAD Desktop and Palm to compile statistics by game type. The Game Type parameter will default to Season.

Scheduled innings

You can set the number of scheduled innings for each game between 3 and 16. When the players have completed that number of innings without a tie, ScorePAD will automatically mark the game as complete. ScorePAD will prompt you to set the game's End Time after the last out of the last scheduled inning or after the winning run scores in bottom of the last scheduled or any extra inning.

If you are using the International Tie-Breaker Rule (ITR), and the game is tied at the end of the last scheduled inning, ScorePAD will automatically implement the ITR placing a runner on second at the beginning of each half inning.

If you neglected to set the Scheduled Innings value to the correct number of innings and ScorePAD prematurely ends a game, you can change the Schedule Innings value, set the End Time of the game to "In Progress" and resume scoring.

Series ID

The Series ID identifies a game as belonging to a specific series of games between two teams. Selecting an ID for each series will allow ScorePAD to compile series-oriented statistics.

Initial count

In some softball tournaments, each batter comes to the plate with an initial count. ScorePAD allows you to set the initial count to any of the following counts:

- 0 Balls, 0 Strikes
- 1 Ball, 1 Strike
- 2 Balls, 2 Strikes
- 3 Balls, 2 Strikes

ScorePAD adds balls and strikes to bring each batter that comes to the plate to that initial count. You can change the initial count at any point during the game by returning to the Game Parameters dialog.
Free Form checkbox

The Free form check box allows the scorer to score any at-bat on the entire score card. If you want to only score the at-bats of a single player during the game, you may use free form mode. As the game progresses you touch the square of the score card that represents the at-bat of the player in the current inning and ScorePAD presents the proper GSP view.

If you come to a game late, you may use free form mode to catch up and then switch to the standard mode. In free form mode, ScorePAD does not keep score or keep track of outs or batters.

DH may be used checkbox

When a team uses designated hitter (DH) that hitter bats in the place of a defensive player. In Major League Baseball that player is always the pitcher. Whenever either team in a game uses a DH, check this box and place the defensive player for which the DH bats in the last lineup slot. This will allow ScorePAD to gather defensive statistics for that player without placing him or her in the batting order.

When you have checked this checkbox, a lineup slot will appear at the end of the score card with no at-bat squares adjacent to it. You do not have to assign a DH when this box is checked.

Add players to database checkbox

This flag tells ScorePAD's conduit whether or not to add any penciled-in players to your desktop RosterPAD database. If you check this box, any players you add to the game by manually writing them in will be added to RosterPAD's desktop database during your next HotSync. If you have performed a Save Lineup operation for a given team from ScorePAD (see Ending a game), that teams players have already been added to RosterPAD's database and there is no need to use this checkbox.

This flag is automatically turned off when you start ScorePAD.

For teams that you do not expect to face again, you will want to leave this box unchecked. Once players are added to the desktop RosterPAD, they will HotSync down to the Palm RosterPAD database. Once you add players to your Palm's RosterPAD database, they will be added to the desktop Roster database during the next HotSync operation. No matter the way you add player to the Roster database, they will end up on both the Palm and desktop Roster databases.
Don't Synchronize checkbox

If you do not want a specific game to HotSync to ScorePAD 's desktop database, you can check the Don't Synchronize checkbox for that game.
Filling in the Score Card

The ScoreCard view displays the status of the entire game. This view shows you the following game information:

- Game number
- Opposing teams and scores
- Player’s name, number, & defensive position
- Game duration
- Individual at-bat results for each player
- Current inning and batter

Tapping the Batter button takes you to the current at-bat.

Each individual square to the right of lineup player information on the ScoreCard view represents an at-bat. Once at-bats are scored, ScoreCard squares graphically represent a number of events that occurred during that at-bat. The graphic below shows each graphic component of the an at-bat square and the event that it represents.
Each at-bat square graphically represents one or more of the following information about the at-bat:

- On-base or out result
- Base advances
- Stolen base
- Out on-base
- RBI from 1st, 2nd, and/or 3rd base
- Out (without reaching base)
- Pitcher change
- Batter change

The game view shows you nine players and up to nine innings. If you have scored one to six innings, this view shows player full last name and defensive position. After six innings, this view changes as follows:

- Innings 1-6: Player number, name, defensive position and all at-bats
- Innings 7-8: Same as 1-6 but compressed player name
- Innings 9: Player number, partial last name, and 9 innings of at-bats

During the seventh and eighth innings, the players' last names are reduced in size. After scoring nine or more innings, the defensive position is removed from this view. You can still change defensive positions in this view, the Edit Lineup View, or the Lineup Wiz.

If you have more than 9 players per team you will need to scroll down using the up and down buttons on your PDA. In order to see extra innings you will need to use the arrows at the top of the screen to scroll.
Creating the starting lineup

ScorePAD automatically loads the rosters of the teams you select in the Game Setup View. In the ScoreCard view you will select the lineups for each team.

If you have never saved the starting lineup for either team, no player names will show up on the score card. If you have saved a starting lineup for the current team, the last saved lineup will automatically appear on the Score Card view.

To select lineups you must:

1. Select the team
2. Select a batting order
3. Select a defensive position for each player

Selecting a team’s scorecard

In the Title Bar, ScorePAD displays the team names, and scores. These name/score displays serve a dual purpose. In addition to showing the current scores, they serve as buttons to select team cards. By touching either team, you select that team’s score card. The selected team will appear in reverse. In the example below, Rawhides (RAW) is selected.

Selecting players

Tap lineup position  Tap player in list  Player appears in Lineup
To select a player when RosterPAD players have been pre-entered:

1. Touch the batting slot you wish to change.
2. A list box will appear with the names of all players entered for that team. The player list box will show position players first, then pitchers. Each list is in alphabetical order.
3. Touch the name of the player you wish to place.

Once you have selected a player for each slot in the batting order, the lineup is almost complete.

If you have not entered players for the selected team into RosterPAD, the Lineup view will appear whenever you tap a player position.

Moving players around in the lineup

The Score Card view provides a graphical interface for moving players around in the lineup. This operation is very useful for minor batting order changes from day to day. You can only move a batter if that batter and all batters between that batter and the destination slot have no plate appearances or the originating and destination batters have no plate appearances.

After all players have batted, you can still use this function if the starting slot and destination slot batter have not completed plate appearances. In the case of two or more players entering the game at the same time, you can use straight substitution until one of the players come to the plate. Then you can swap players in the batting order until you arrive at the correct batting order of the new players.

To change a players batting slot:

1. Touch the players name.
2. While holding down your pen, slide the player to the destination batting slot. Batting slots will highlight and un-highlight as you move your pen over them.
3. When the destination batting slot is highlighted, lift your pen. The player will move to that batting slot.
Setting defensive positions

Finally, you must set the defensive positions of your lineup. ScorePAD makes this task just as easy as setting the lineup. Touch the box to the right of player's name. A list box will appear with all defensive positions recognized by ScorePAD. Tap the correct defense position and you are done. You should have one and only one pitcher per lineup. If no pitcher is selected pitching statistics are credited to Unknown Pitcher.

When you have selected defensive positions for each player, you have completed the starting lineup. You can also set the lineup and defensive positions in the Lineup Wiz and the Lineup View.

Creating lineup without RosterPAD data

In some cases, (e.g. tournaments) you do not have rosters for opposing teams. In these cases you can use the Lineup view to create and edit ScorePAD lineups.

To move to the Lineup view, select Edit Lineup from the Options menu of the Score Card view.

You must enter player numbers for each player in the lineup. Last name, first name, and position are optional. If you enter a player number and RosterPAD has team data, the Lineup view will automatically fill the name and position fields. If your lineup has more than 10 players, you may use the scroll bar on the right to scroll to the remaining players. For details on the use of the Lineup View see The Lineup View later in this chapter.

Saving the starting lineup

If you have scored professional baseball games, you have probably recognized that starting lineups do not change very much from game to game. ScorePAD gives you the benefit of saving the starting lineup for a given game to use for the next game you score.

To save the starting lineup:

1. Select Save Lineup from the Options menu.
2. ScorePAD will prompt you to save either or both of the teams' lineups.
3. Select the lineup(s) you want to save

ScorePAD will update your RosterPAD database with the defensive position and batting slot of each starting player for the team(s) you select. If any of the
players don’t exist in RosterPAD’s database, ScorePAD will add them.

The score card with complete lineup

When you have completed the starting lineup, the ScoreCard view will show each player’s number and defensive position. Since you have not begun scoring the game, the grid of at-bats for all innings and all players will be blank.

Score Card view with a complete lineup

Player substitution

As each team substitutes players, you must make changes to your score card to reflect those substitutions. Changes in the lineup take place in two forms; straight and double switch.

Straight substitution

In a straight substitution, one or more players enter the game in the same batting order and defensive positions as the players they replaced.

Double switch substitution

In a double switch, two or more players enter the game in different defensive positions than the players they replaced in the batting order. For instance, a coach might bring in a new pitcher and a left fielder. In a double switch he places the left-fielder in the current pitcher’s batting slot and the pitcher in the current left-fielder’s batting slot.

In Major League Baseball a coach usually decides to perform a double switch when the pitcher is scheduled to have an at-bat in the next inning but the coach wants a better hitter to bat in that spot instead.
With ScorePAD you can substitute any player for any other player. ScorePAD maintains statistics for all players that participate in a game whether starting or substitutes.

**Substitution flexibility**

If a double switch occurs in a game and you are not sure of the batting order assignments of the players that entered the game, you can perform a straight substitution and change the batting order as the substituted players come to the plate. To change the order as the players come to the plate, you must use the Lineup Wiz or ScoreCard view’s drag-and-drop capability to swap the batting order positions of any of the players that have not come to the plate. (See Moving players around the lineup.)

The Lineup Wiz also offer flexibility in moving players among defensive positions. If you assign players to the wrong positions or players change positions, you can use the Lineup Wiz to make corrections or position changes. Lineup Wiz uses a drag-and-drop interface to assign players to defensive positions or move players among defensive positions.

**Missed substitutions**

If you miss a substitution some time during the game you can easily correct the mistake. Replace the player you want to substitute for from the Lineup Wiz or ScoreCard View with the missed player. Select Missed sub from the prompt and from the Retroactive Substitution pop up menu select the inning and batter when the substitution was supposed to occur.

You can use the following screens to perform substitutions:

- **ScoreCard View** - all substitutions and defensive changes until 9th inning
- **Lineup View** - all substitutions and defensive changes
- **GSPView** - Pitching change, Pinch-hitter, and Pinch-runner
- **LineupWiz** - all substitutions and defensive changes (recommended)

**Making substitutions in the ScoreCard View**

To substitute a player in the ScoreCard view, touch the name of the player in the batting slot for whom you want a player to substitute. When the list of team players appears, touch the name of the player entering the game. ScorePAD will always prompt you as to whether you are making a substitution or correction. If you do make a correction, ScorePAD will ask you to reassign any previous at-bats to the corrected player.
Making substitutions in the Lineup View

If you tap a batting slot in the ScoreCard view and the team of the player being substituted, has not been entered into RosterPAD, the Lineup View will appear. This view allows you to change the names, player numbers, and defensive positions of any player in the lineup. You can use this view to make substitutions whenever you don't have a team entered into RosterPAD. Whenever you change a player's number or defensive position in the Lineup View, ScorePAD will prompt you as to whether this change is a correction or a substitution. Any other change is taken as an update or correction to player information.

Making substitutions in the GSP

You can perform three types of substitutions in the At-bat or GSP view:

1. Pitcher substitution
2. Pinch-hitter
3. Pinch-runner

To perform pitcher substitution:

Hold pen down on pitcher's mound for 2 seconds

Select new pitcher from list

To select a pinch hitter, perform the following steps:
Hold pen on home base for 2 seconds, list will pop-up

Select the pinch-hitter from player list

The new pinch-hitter

To select a pinch-runner, perform the following steps:

Hold your pen on an occupied base Select pinch-runner from the list
Select the name of the pinch-runner from the list

**Adding players that are not part of a RosterPAD Roster**

If you have created a RosterPAD database for a team and have not added all of the players for that team, you can "write in" players in any game either as a starter or a substitute.

When the roster list appears in the ScoreCard, GSP, or Lineup Wiz views, you will see the line "**Write-in**" at the top of the list. If you select **Write-in** ScorePAD will display the Edit Player dialog. This dialog allows you to write in a starter or perform a substitution as if you were using the Lineup View.

The Edit Player dialog will also appear when you attempt to create lineups or perform substitution in the GSP view or Lineup Wiz when you do not have RosterPAD data for a team.
The Lineup view

You can use the lineup view to perform the following:

- Select or substitute lineup players
- Select or change defensive positions for lineup players
- Gain access to substitutions
- Edit player detail
- Clear lineups
- Swap teams and lineups
- Undo the last substitution

Editing the lineup

You can use the Score Card view to perform lineup setup and player substitution for teams that have all of their players in RosterPAD. If you have not entered players into RosterPAD, the Lineup Dialog will allow you to write player numbers and names into the lineup. You can also select RosterPAD players in the Lineup dialog.

To select a player from RosterPAD, touch the number of the batting slot to which you want to assign a player. A list box will appear with all player names previously entered into RosterPAD. Touch the player you wish to add to that batting slot. You may also select RosterPAD players by entering the player's number. The player's name and defensive position will immediately fill in if that player number corresponds to a player entered into RosterPAD.
Clearing lineups

To clear a lineup, select Clear Lineup from the Options menu. This option will clear the lineup of the currently selected team. This option is only available before you score the first at-bat of a game. If the current team has RosterPAD players, and you exit the back to the ScoreCard view, ScorePAD will fill any empty lineup slots with saved lineup players.

Swapping teams and players

If you fill out a lineup card but put the visiting team under the home team area of the score card and vice versa, you can swap the lineups and team names with a single command. Select Swap Lineups from the Options menu. This option is only available before you score the first at-bat of a game. You can also swap lineups in the ScoreCard, and Lineup Wiz views.

Editing substitutions

You can edit any substitution for any lineup slot of either team. You can identify each lineup slot that includes substituted players in the Lineup View by the "S" displayed is the right-most column of a lineup slot.

Tap the "S" to access the Substitutions sub-view.

![Lineup view](image1)

Substitutions sub-view

The Substitutions sub-view contains the following fields for each substitution:

- **#**  Player number
- **Last**  Last name
- **First**  First name
- **Pos**  Defensive position
- **In**  Inning player entered the game
- **O**  Inning player left the game
**AB**  At-bat during inning after which player left the game (if on defense)

Under this Substitutions sub-view, you can add, delete, or change any player substitution entry. For a player to get credit in offensive or defensive statistics, you must make sure that you include that player in either the Lineup View or Substitutions sub-view. When you make lineup changes or substitutions in the Score Card, GSP, or Lineup Wiz, ScorePAD, automatically creates lineup entries and substitution entries in two screens. You will only need access to these screens to correct errors you make in lineup changes.

**Undo last substitution**

You can undo the last substitution as many times as you like during a game. From the **Options** menu select **Undo last substitution** either in the GSP, Lineup or Lineup Wiz views. You will be prompted to either select Erase Substitution or cancel.

---

**Player detail**

In both the Lineup View and Substitutions sub-view, you can edit player detail. To access player detail for any player, tap in the First or Last name fields of the a lineup or substituted player then select **Edit player detail** from the **Options** menu.
- Change player batting hand and throwing hand
- Charge additional errors (errors not causing reaches or advances)
- Charge pitcher with save opportunity (if no save awarded)

For write-in players, their batting and throwing hands default to Right. The Save Opportunity check box only appears when a player’s defensive position is Pitcher.
The Lineup Wiz

The Lineup Wiz is a graphic view of a team's batting order and defensive assignments. This graphic view gives you the power to do the following for both teams:

- Assign players to the batting order
- Drag-and-drop players up and down the batting order
- Drag-and-drop players from the batting order to defensive positions
- Select players from the roster directly to defensive positions
- Drag-and-drop players from one defensive position to another
- Discern which defensive positions are not filled
- Discern which defensive positions have more than one player assigned

You can get to the Lineup Wiz in the following ways:

1. By selecting Lineup Wiz from the Options menu of the ScoreCard view.
2. By pressing the “d” button on the left side of the GSP view (Under the HR).
3. By pressing Go to Lineup Wiz button when ScorePAD prompts you before the first at-bat of each half-inning whenever the team going on defense doesn’t have all of its defensive positions assigned. You must set the Check for complete defense preference in the GSP view to have ScorePAD prompt when the defense is incomplete.

Assigning players to the batting order

You can assign players to the batting order of the Lineup Wiz in the same way you assign players in ScoreCard view. Touch the Position to which you want a player assigned. If that player’s team has a RosterPAD database, the Lineup Wiz will display a list of players. Touch the player you want to assign to complete the operation. If the team does not have a RosterPAD database, the Edit Player
dialog will appear allowing you to use Graffiti to write-in the player’s number, last name, and first name. You can use your pen to select from a list of defensive positions. Only the player number is required.

You can also assign a player to the next open batting slot by touching a defensive position, then selecting or writing in a player. This action assigns the defensive position you touched to the player you selected and adds that player to the next open batting order slot. This feature is handy when you do not have a lineup card but you can see the players in the field. You always use drag-and-drop to change the batting order as the players come to the plate.

Dragging players to defensive positions

Once you set the lineup, you can drag players into defensive positions by putting your pen on the player, holding down your pen, and dragging the player onto a defensive position. You can tell that a defensive position is unassigned when it appears highlighted on black and white displays or red on color displays.

Dragging players around the lineup

You can move players up and down the lineup by dragging them with your pen. To change a player's lineup position, touch the player with your pen, drag the player to a new lineup slot and lift your pen.

The player you want to drag and the destination batting slot must not have had an at-bat. This feature helps when you know the defensive setup but don’t know the batting order. You can set the defense while the team is in the field, then drag-and-drop players into their proper lineup slot as they come to the plate.

Swapping defensive positions

You can swap defensive positions between two players by dragging from one defensive position to another. If the destination defensive position is not assigned, the dragged player will be assigned to the destination defensive position and the original defensive position will become unassigned.

Discerning open and duplicate defensive positions

When a defensive position is open it will appear in reverse on the right side of the Lineup Wiz. When a position is assigned to 2 or more players, the position abbreviations next to each player will appear in reverse (red on color displays).
Lineup Wiz Examples

There are multiple ways of making substitutions in Lineup Wiz. The descriptions below will guide you through all the possibilities. In this example there are 12 players in the lineup (all bat) but only 9 play defense. These same methods can be used by leagues that play and bat only 9 players at a time.

Lineup with 12 players but only 9 have defensive positions. The screen on the left shows 3 of the players with no position. The screen on the right shows a substitution being made at 3rd base by tapping on the position.

In this example the 3rd baseman has been replaced by the player batting 10th but had no defensive position. The dialog above pops up when the substitution is made. In this case we will have the player being subbed for at 3rd base move to first base defensively. Before selecting the Yes button use the down arrow to select the 1st base as the new position. Then select Yes.
Once again the dialog box appears but in this case the starting 1st baseman moves to position none. This allows the player to remain in the lineup batting 7th.

Another example shows an existing fielder being moved to no position but remaining in the lineup.

Touch the position next to the players name and a dialog box appears (see screens above). In this case we will select Position Change. It now leaves an opening in RF and this time we touch the position next to the player we would like to become the new right fielder.
A third example shows by selecting the position on the field. A substitution can be made straight up using this method (one player replacing another).

In this instance, Stone is a new player entering the game and it prompts a dialog box asking about the substitution. When selecting substitution the new player assumes both the position and batting order slot held by the player he replaced.
After substituting a new pitcher (on the previous page) the final result of all the changes are shown below.
Scoring an At-bat

The GSP view

ScorePAD designed the GSP view to include almost every detail of the current at-bat. Information available on this view include:

- Player name and number
- Player game at-bat stats
- Player batting order
- Ball & strike count
- Pitch sequence
- On base results
- Out results
- Base advances
- Batting hand of batter
Since you will spend most of your scoring time in this view, we have made most scoring actions available on Game Situation Panel. This view represents a single square on the typical score sheet. However, it also displays game status including graphic indicators for each base runner during the current at-bat. As you finish scoring an at-bat, ScorePAD calculates new statistics and moves to the next logical batter. ScorePAD continues to move to the next batter in the batting order until three outs are recorded.

As the teams switch between offense and defense, ScorePAD keeps track of the batting order and automatically presents you with the proper player for the upcoming at-bat. ScorePAD also recognizes when the last batter of the last inning should return to the plate in the next inning. This happens when his at-bat is interrupted by a teammate making the third out before his at-bat is complete (for example, caught stealing, picked-off, etc.)

Along the right side of the at-bat square you will notice buttons: Ball, Strike, Foul, POA (Pick-off Attempt), N (No Pitch), Prev, and N ext. The first five buttons allow you to record pitches counted against a pitcher's pitch count; the
other two move you to the previous and next at-bats. You can set Preferences to include only balls and strikes in the pitch count.

**Batter information**

Along the top of the GSP view, the title bar of each at-bat contains:

- Player number
- Player name
- Player batting slot
- Player game batting record

**Game/at-bat status**

The GSP view shows game status on the line directly below the title. The right side of this line shows the visitor's team and score followed by the home team and score. The left side shows the inning half, inning number, and the number of outs.

Below the at-bat square you will find the result line. The result line contains a verbal description of the at-bat result. This line exists to help make an association between some of the abbreviations in the scoring square and generally understood baseball terminology.

**Pitch line**

Under result line you'll find the pitch line. On the left, the pitch line displays the pitch result sequence. You will see one letter for each pitch using the following mnemonics:

- B = Ball
- S = Strike - swinging
- L = Strike - looking
- F = Foul
On the right side of the pitch line you will find the pitch count. The pitch count shows the number of balls (B), strikes (S), and total (T) pitches. Balls and strikes will not always add up to the total since ScorePAD includes No Pitches and Pick-Off Attempts in the total pitch count. Since they are neither balls nor strikes, ScorePAD won’t include Pick-Off Attempts or No Pitches in either B or the S counts.

At-bat result buttons

You will find the result buttons Out, On Base, and Advance at the very bottom of the GSP view. While you record balls and strikes you will see the Out and On Base buttons at the bottom of the view. Once the player has reached base, the Advance button takes the place of the On Base button. To record an at-bat result, touch Out or On Base and pick from the list of results.

Visual cues

This view also gives you visual cues that show more game information. The at-bat visual cues are:

- Shaded squares for each occupied base
- Darkened base paths for those run by batter
- A line to show the destination of the ball put in play
- Darkened ball and strike squares
- Square around hit or walk indicator, where applicable

Visual cues increase your enjoyment of the game as you score. They show the game/at-bat status at a glance thereby increasing the time you spend actually watching the game. ScorePAD automatically generates these graphical indicators with the exception of some ball put in-play destinations.
Scoring procedure

In ScorePAD, a game is simply the aggregate of all of its at-bats. ScorePAD at-bats contain:

- Pitcher
- Pitch sequence
- Pitch results
- On-base and/or out reasons
- Destination of ball put in play
- Base advance reasons and players
- Pitch detail

To score an at-bat, follow the steps below:

1. Record balls and strikes by pressing the appropriate buttons
2. Touch either the Out or On Base buttons
3. Choose the on-base or out type
4. Touch on playing field to show where batter hit ball
5. Touch the Advance button to move batter around bases or drag-and-drop runners
6. Touch the Out button and reason to show batter out on-base

Recording pitches

Since you will spend a great deal of time watching and recording balls and strikes, we make this operation simple and flexible. Some scorers are used to the routine of looking up for the pitch and looking down to record the pitch (some for several decades.) If you want to maintain that habit you can either touch the one of the five pitch buttons,
If you want to watch the game without looking down for every pitch, touch the proper pitch buttons to record pitches. You will probably have to look down at them at first. After memorizing the buttons you will enjoy looking at the game and touching the proper button to record a pitch.

The Palm OS device hardware buttons only work this way in the GSP view of ScorePAD. To move to other Palm OS device applications, touch the Card button to move to the ScoreCard view. Once in the ScoreCard view, the buttons will work as normal.

You can configure the hardware buttons in the GSP view. Select Button Preferences from the Options menu to bring up the Button Preferences dialog. You can set any button to any function. Valid button functions are: Off, Pick-off attempt, Foul, Ball, Strike-swinging, Strike-looking. If you set a button to off, that button will default to its regular Palm function. See Button Preferences Dialog for more detail.

The No Pitch

ScorePAD allows you to record a No Pitch by touching the N button. Fortunately, this rarely occurs. A no pitch happens when the pitcher attempts a pitch and for some reason, either the batter asked for time-out, the umpire was not ready, something or someone interfered, or for some other reason, the umpire calls “No pitch,” and throws his hands up and forward. The pitch still adds to the pitch count but is not called a ball or a strike.
Reaching base

When a batter reaches base on a base on balls or a hit, tap the proper on-base button on the left side of the at-bat square.

- BB - Walk or base on balls
- 1B - Single
- 2B - Double
- 3B - Triple
- HR - Home run

For other on-base types, touch the On Base button at the bottom of the GSP view and select the proper on-base result.

Visit the Reference chapter in this manual for a list of on-base results and their reasons. Once you select an on-base result, all pitch buttons disappear and a single Pitches button appears. To view or edit pitch detail, touch the Pitches button.

You can cancel the on-base result you selected by touching the Undo button. This button does not undo the runners that you advanced after you placed the batter on-base. You will need to use the Prev button to get back to each batter and undo any changes made.

Destination of ball put in play

ScorePAD allows you to select destination of hit or out by directly touching the location of the ball on the screen.

Charge dropped foul or additional error

When a batter’s at-bat is extended due to an error in foul territory you can select AtBat from the GSP view and tap Charge additional error. Then select the defensive position charged with the error and follow the prompts to complete the play. When finished it will bring you back to the current batter.
Advancing base runners

When you select an on-base result, the On Base button disappears and the Advance button appears. After touching the Advance button, select the proper advance reason from the list. Advance reasons such as batter advance will prompt you for more information. If runners are on-base, ScorePAD will prompt you to advance those runners unless the advance of runners on-base is automatic. In the case of a Hit-by-pitch, Walk, Triple, or Home run, base runners are automatically advanced.

You can also move a baserunner through prompts created by ScorePAD. Simply tap on the base the runner now occupies or use the selections below to take care of all baserunners at once or to throw a baserunner out at a specific base.

Drag and drop base advances

While you record the at-bat of current batter (the batter now at the plate,) you can use the Drag-and-Drop runner advance feature.

Drag-and-Drop base advances were designed to allow you to advance runners on base while recording the balls and strikes for the current batter. This function saves you the effort and time of moving from one at-bat to the next every time a runner advances. Drag-and-drop allows you to advance any runner presently on base from the screen of the batter at the plate. Drag-and-drop base advances will not work in some cases if the current batter has reached base.

To use Drag and drop, complete the following steps:

1. Touch your pen on any occupied base and drag from that base to the destination base for that runner. The base will highlight when you have dragged far enough.
2. Lift your pen. ScorePAD will display a list box of Advance types.

3. Select the appropriate advance type.

   Touch Runner  Hold pen down and drag to new base  Select advance reason

You can also touch any occupied base to move to that at-bat screen.

1. Once you are at the runner's at-bat screen, touch the Advance button.

2. Select the appropriate advance type.

3. ScorePAD will prompt you for the destination base for that runner. Select the destination base.

4. Once you have completed work on that at-bat, touch Home plate and ScorePAD will take you back to the current at-bat.

**Note:** Drag-and-drop runner advances were designed as a convenience. During an at-bat, if a runner steals a base or advances on a wild pitch, passed ball, etc., you can use drag-and-drop.

**Recording an out**

The GSP view allows you to record outs four ways.

- When you are keeping pitches and record a total of three strikes, the GSP view assumes that the batter struck out.

- Whether a batter has reached base or not, you may touch the **Out** button at the bottom of the GSP view and select an out result. The out result list also contains Strikeout so you can select Strikeout from the list if you do not wish to touch strike three times.

- You can record outs using Graffiti abbreviations. When using Graffiti to
record outs you write the an abbreviation of the out result. For example, writing "63" and the return gesture represents a grounder to shortstop thrown to first for the putout. "F8 return" would be a flyout to center field.

When runners are on base, you may hold your pen on the runner for two seconds. When the list of out on-base out results appears, select the proper out type and record the defensive positions that assisted or performed the putout.

**Defensive Positions**

Some outs will require that you enter the defensive positions that assisted in or completed the putout. The Defensive Positions dialog will appear when the at-bat needs that information.

The Defensive Positions dialog shows the defensive positions by their position names. To record defensive positions, touch each position that assisted in or completed the putout. As you touch a defensive position button, the position number for the position button you tap appears on the edit line on the bottom-left of this dialog. The **Cancel Out** button will appear until you enter defensive positions. Once you enter defensive positions, the **Cancel Out** button will change to **Finish Fielders**. When you finish entering defensive positions, press **Finish Fielders**.

If you make a mistake, touch the **Undo** button to erase that entry. If you want to cancel the out after you have entered one or more defensive positions, press the **Undo** button until **Cancel Out** reappears. Finally, press the **Cancel Out** button.
**Base running outs**

If the current batter has not completed his at-bat:

1. Hold your pen on the shaded base of the baserunner until a list of outs appears.
2. Select the out type for the runner.

You can also touch the base of the base runner or use the navigation buttons described in this chapter to move to the at-bat of a base runner. You can then press the Out button and select an out type for the runner.

**Switching sides**

When you press the Next button, ScorePAD moves to the next logical batter based on the game situation. After three outs, ScorePAD will move to the first logical batter on the opposing team.

In the case of maximum run rules or even the mutual agreement of the coaches and umpires, teams may switch sides in situations where there are less than three outs. In these situations, use the Switch Sides menu command. This GSP view menu command causes ScorePAD to immediately move to the next logical batter of the opposing team.

**Skip At-bat**

ScorePAD allows you to skip a batter. In games that use free substitution rules, players might leave the game leaving nine or more players in the lineup. Since you can't reduce the size of the lineup once you have gone through the entire lineup, ScorePAD allows you to skip that player's at-bat and score the next batter.

In cases where the team has eight batters, the ninth batter would probably not be skipped but counted as an out. In these cases, don't use Skip At-bat. Give that batter an out.
Clear At-bat

With Clear At-bat you can erase all of the events of an at-bat. This command quickly removes all pitches, base advances, reaches, outs, and hit location.

Advanced scoring - Graffiti abbreviations

Once you become an official expert baseball scorer (if you are not already), you can use ScorePAD abbreviations to score at-bats. You must use Graffiti to enter these abbreviations. ScorePAD recognizes abbreviations to speed up scoring for those familiar with baseball. Scoring this way feels nearly equal to scoring with paper. As you write the abbreviation with Graffiti, the letters you enter will appear directly below home plate of the GSP view. You must terminate your abbreviation with the down forward slash (the same stroke that you use to begin a new line.) Below is a partial list of Graffiti abbreviations that ScorePAD recognizes.

- 1B - Single
- 2B - Double
- 3B - Triple
- HR - Home Run
- BB - Walk or Base on Balls
- HB - Hit by Pitch
- K - Strikeout - prompt for strikeout type
- Kc - Strikeout - last strike called
- Ks - Strikeout - last strike swinging
- 63 - Groundout short to first
- T2 - Tag out by catcher (defensive position 2)
- L3 - Line out to first base (defensive position 3)
- F8 or 8 - Fly out to center field (defensive position 8)
- DP463 or 463 - Double Play
- LDP43 - Lined into double play; lined to second runner out at first
- E6 - Reached base on an error to short
- FC 64 - Reach base fielder's choice, runner on first out short to second
- FF5 or 5F - Foul out to third base
- P6 - Popout to shortstop

ScorePAD recognizes many more abbreviations. This is just a partial list. Check the Reference chapter for an exhaustive list of abbreviations.

Navigating between at-bats

ScorePAD gives you several ways to navigate between at-bats in both the Score Card and GSP views:
Tap an at-bat on the Score Card view
Tap the Batter button on the ScoreCard view to go to the current batter
Tap the Prev or Next buttons on the GSP view
Tap a shaded base to go to the at-bat of the baserunner
Tap home base to go the current at-bat
Tap any of the previous at-bat graphics on the GSP view to go to previous at-bats of the current batter
Use the graffiti back-arrow gesture to move to the previous at-bat of the batter
Use the Graffiti forward-arrow gesture to move to the next at-bat of the batter

ScorePAD records at-bats in the order they occur. As you move backward you may move from one team to the next.
The **Next** button moves you forward to the next at-bat. ScorePAD observes the number of outs and moves you to the correct team and batter. This happens only when you touch the Next button while at the current batter. The Next button disappears while the current batter is at the plate. When you enter a result, either out or on-base, the Next button reappears. When you reach the last out of the game, or the winning run is scored in the bottom of the last inning, the next button will disappear again.

You may also use the up and down Palm OS device hardware buttons to move from one at-bat to the next. The top button moves you to the previous at-bat while the bottom button moves you to the next at-bat.

Making changes

ScorePAD allows you to edit most information on an at-bat. The following methods are useful in correcting at-bat information:

- The Undo button
- The At-bat Details dialog
- The Advances dialog
- The Edit Runs dialog
- The Edit Lineup view
- The Pitch Details dialog
Undo button

You can always Undo actions you have performed on an at-bat. The Undo feature removes actions in the following order:

Base advances
Reach or out result
Balls and strikes

Undo will also take away the base advances by other players during the play.

Edit At-bat Details

At-bat Details dialog

You can edit the attributes of an at-bat using the At-bat Detail dialog. If you missed a substitution and need to change the batter of the at-bat, use the at-bat detail dialog. See the At-bat Detail dialog for a list of all information that you can change. You can access the At-bat Details dialog by tapping the Details button in a completed at-bat or select Edit At-bat Details from the At-bat menu of the GSP view.

10.18i Rule

AtBat Detail allows you to account for the 10.18i rule. In simple terms, this rule states when pitchers are changed during an inning, the relief pitcher shall not have the benefit of previous chances for outs not accepted in determining earned runs.

The AtBat Detail allows you to make a run unearned to a team and earned to a pitcher at the same time.
Quality at-bat and Big Play (Deluxe Version Only)

There are two check boxes in At-bat detail that can be used to designate any at-bat a **QltyAB** or any good defensive play a **Big play**. Checking or not checking these boxes are at the sole discretion of the scorer. ScorePAD will not assume any at-bat or defensive play a quality at-bat or big play.

**Edit Advances**

![Advances dialog](image)

The Advances dialog allows you to change the batter and pitch during which a runner advanced. This information is useful for desktop statistics like runners advanced and runners in scoring position. To access the Advances dialog, tap the **Advncs** button on the GSP view.

**Edit runs**

![Edit Runs dialog](image)

The Edit Runs dialog allows you to change the Earned Run and RBI status of any run scored. Although you can use the At-bat Detail dialog to make these changes, you would have to go to the at-bat of each run. This dialog shows you...
all of the runs scored by each team and gives you the opportunity to change them in one place.

**Edit Lineup**

The Edit Lineup view allows you create or change the lineup. This view has two levels. The top level allows you to edit details of players already in the game or to add substitutions to the game. To access the Lineup view, select *Edit Lineup* from the Options menu of the Score Card view or the At-bat menu of the GSP view.

After you have made one or more substitutions to a lineup position, you can go to the next level. The second level allows you to change the details of players for which you have substituted. To drill down to substituted players, tap the "S" in the right-most column of the Lineup View.

**Official Scoring Change**

Official scoring change was designed for easy editing of how a runner reached base. A good example of this function would be if an error is later changed by the official scorer to a base hit. From the GSP view of that at-bat select *Official scoring change* under the AtBat dialog. This will allow you to make the change.
Statistics

Batters

The Batter Stats dialog shows each batter's offensive statistics during the current game. This dialog displays the number of at-bats, runs, hits, RBI, walks, strikeouts, stolen bases, and season batting average for each player in the lineup and includes team totals on the bottom. You may select either team by pressing the team selector at the top of this dialog.

<table>
<thead>
<tr>
<th>Batter</th>
<th>EER</th>
<th>RAW</th>
<th>AVG</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webster</td>
<td>3 2 1 0 0 1 0 0 292</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corbridge</td>
<td>4 1 1 0 1 0 1 0 300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jackson</td>
<td>3 1 3 1 4 0 0 1 459</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thyges</td>
<td>2 1 1 1 1 1 0 0 250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Joseph</td>
<td>3 0 1 0 0 0 0 0 227</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spriggs</td>
<td>3 0 0 0 0 0 0 0 195</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elder, D.</td>
<td>2 0 0 0 0 1 1 0 176</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bosley</td>
<td>3 0 0 0 0 0 0 0 150</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Booth, R</td>
<td>2 1 1 0 0 1 1 0 300</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Batter Stats Dialog

Pitchers

The Pitchers dialog shows game statistics for each pitcher. In the ScoreCard view, pitchers of the displayed team appear on the Pitchers dialog. Conversely, in the GSP view, pitchers of the opposing team appear on the Pitchers dialog. You may switch teams by pressing the team selector at the top of this dialog.

<table>
<thead>
<tr>
<th>Pitcher</th>
<th>EER</th>
<th>RAW</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gaffney</td>
<td>7 9 6 6 9 0 1 112</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stone</td>
<td>3 2 0 3 1 0 17</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Pitcher Stats Dialog
Line Score

The Line Score dialog shows the number of runs scored in each inning by each team. Invoke the Line Score dialog by selecting Line Score from the Stats menu in the ScoreCard and GSP views. In the event the game lasts more than nine innings, the Line Score dialog will display the last nine innings of the game at all times.

Spray Charts (ScorePAD Deluxe Only)

Spray charts can be accessed in two ways. One way is from the Stats menu and the other is by tapping the circled S in the GSP view.

Spray charts track and compile direction of hits and outs for both individual players and entire teams. Use the arrows to select an individual pitcher or all pitchers and individual batters or all batters.
The chart includes statistical information and when the boxes are checked for those categories it tallies the total amount. The categories are Hits, Outs, Left (left-handed batters), Right (right-handed batters), Grounds (groundballs), Fly (flyballs) and Line (line drives).

Spray charts can also be used to set defensive alignment. In the example below the centerfielder has been shifted towards left field and the rightfielder has been shifted towards center.
Instant Stats

In the GSP view, you can take a quick look at any one of seven pop-up screens to view instant game and season statistics. When you hold your pen down in designated areas of the GSP view, Instant Stats screens pop-up and remain up until you lift your pen. This feature allows you to take a quick peak without missing the next pitch.
Pitch Charting (ScorePAD Deluxe only)

To perform pitch charting in ScorePAD you must set the Pitch Detail preference in the GSP view.

1. Select Pitch Detail Preferences from the Options menu to bring up GSP view preferences.

2. Check Record Pitch Detail to start pitch charting. You may also want to check Record Hit Type. This allows you to record the way the batter put the ball in play on a particular at-bat.

If you want to record pitch location from behind the batter, you will want to check Pitch Location From Behind. Checking this allows a more natural location recording sequence from behind the batter. Press OK to exit the Preferences dialog.
With pitch charting turned on, the Pitch Details dialog will pop up after you record each pitch, on base, or out. The Pitch Detail dialog contains the following information:

- Pitch location chart
- Pitch types
- Swing types
- Pitch results
- Pitch speed
- At-bat pitch count
- Current ball/strike count

You can also enter the Pitch Details dialog by selecting Edit Pitches from the At-bat menu of the GSP view.

You can scroll to any pitch and change its detail during the course of an at-bat. This dialog will appear whenever you record anything that involves a pitch.

After each ball put in-play, a list of hit types will appear. As soon as you pick a hit type, the list goes away.

Effective pitch charting means you must show not only the type of pitch and how that pitch was hit, but also where the pitch was hit. To accomplish this you simply touch the part of the field where the ball landed when you return to the GSP view.

You can record balls and strikes in the Pitch Detail dialog if you wish. This feature allows you to remain in the Pitch Detail dialog during an entire at-bat. To record balls, strikes, fouls, and pick-off attempts, you must use the Palm OS hardware buttons. See that chapter on Scoring an At-bat for details on the hardware buttons.

To insert a pitch in the middle of a pitch sequence, touch the plus (+) button. This allows you to insert a pitch anywhere in the sequence without having to delete or change other pitches. To remove a pitch, touch the minus (-) button. The up and down scroll buttons allow you to move between pitches.

When a batter gets out or on-base for any reason other than a strikeout or a walk, you press either the Out or On Base buttons. Both of these buttons add an Inplay pitch, which you can chart. When you press the OK button, ScorePAD will prompt you to enter the out or on-base type and defensive assists and putout if necessary.
The preferences dialog allows you to change preferences for recording at-bat information.

**Pitchers play other positions**

If you are scoring a game in which any defensive player may become the pitcher at anytime, check this box. ScorePAD will allow you to select any defensive player as the pitcher in the At-bat Detail dialog.

**Show batters season average**

This preference allows you to display the season average of each batter on the GSP view. ScorePAD recomputes each batter’s season batting average after each at-bat and re-displays the new average. Depending on the number of at-bats a player has, the average may or may not change.

**Int’l tie-breaker**

This preference turns on ScorePAD’s implementation of the softball International Tie-breaker Rule (ITR). When a game is tied after you complete the last scheduled inning, ScorePAD will automatically place a runner on second or runners on second and third depending on the number of Runners selected. ScorePAD will implement this rule every half inning until an inning completes without a tie score. You can turn this preference on or off at any time.

**Runners**

The field allows you select the number of runners automatically placed on base during innings when the ITR is in effect. If you select one, ScorePAD will place a runner on second base. If you select two, ScorePAD will place runners on second and third base.
**Use short fielder position**

This preference causes the Short Fielder position to appear in the Defensive Positions dialog. The Defensive Positions dialog appears after each out. The Short Fielder position is used in softball as a tenth defensive position.

**Show previous at-bats**

This preference turns on the display of previous at-bat squares for the Score-Card view on the Game Situation Panel (GSP) or at-bat view. Up to 5 of the previous at-bats will display during the at-bat. When the at-bat completes in an out or on-base, the previous at-bats will go away. During the first at-bat, season batting average, home runs, and RBI will display.

**Check for complete defense**

When checked, this preference causes ScorePAD to make sure there is a player assigned to each defensive position. ScorePAD checks defensive positions before the first at-bat each half inning. ScorePAD will display a warning dialog when you have not assigned players to all defensive positions.

**Prompt for infield hits and bunts (Deluxe version only)**

This preference allows you to track infield and bunt hits. After a hit, if you touch the screen somewhere in the infield you will get a prompt asking if this is an infield or bunt hit. In the dialog you can select who fielded the ball.

![Infield Hit Dialog](image)

**ERA Innings**

The preference allows you to select the number of innings the Earned Run Average (ERA) calculation uses to compute a pitcher's ERA. For MLB players this number is always nine. Use a number that indicates the average or fixed
length of games in your league. The calculation for ERA is earned runs multiplied by nine divided by innings pitched.

**Pitch Detail Preferences (ScorePAD Deluxe only)**

**Record pitch detail**

The Pitch Detail dialog will appear after you record each pitch. This dialog allows you to record pitch result, pitch type, pitch location, pitch speed, and swing type. If you do not want to record pitches at this level of detail, do not check this box.

**Record Hit Type**

When selected, ScorePAD will present a list box for each ball put in play. This list box will allow you to pick the hit type. Hit types are Fly, Line, Grounder, Popup, Bunt, and Blooper. Once you pick a hit type, ScorePAD proceeds as usual.

**Pitch location from behind**

If you have checked Record Pitch Detail, and your point of view is behind the batter, this selection allows charting the pitch location from that point of view.

**Pitch count only balls & strikes**

Check this box if you want all pitch counts to include only balls and strikes. Normally, ScorePAD computes the pitch count using the sum of balls, strikes, pick-off attempts, and no-pitches.
**Use “Called strike” button**

Check this box if you want to choose between called and swinging strikes from the GSP view.

**Use “Intentional balls” button**

Check this box if you want to distinguish between balls and intentional balls.
Prompt for strikeout type

Check this box to select from seven different strikeout types.

Prompt for walk type

Check this box to select between called and intentional walks.
The button preferences dialog allows you to change the default behavior of Palm OS hardware buttons. The four buttons at the bottom of your Palm OS device are normally used to switch to Datebook, Phonebook, ToDo, or Memo native applications. In the GSP view, by default they are set to record the following pitch types:

- **Datebook button**: Pick-off attempt (POA)
- **Phonebook button**: Foul
- **ToDo button**: Ball
- **Memo button**: Swing strike

You can use this dialog to change the behavior of these buttons. Any button may be set to any of the following behaviors:

1. **Off**
2. **Pick-off attempt**
3. **Foul**
4. **Looking strike**
5. **Swinging strike**

If you set a button to "off", that button assumes its default behavior and switches you to the appropriate Palm application. Otherwise, each hardware button will record defined pitches while a batter is at the plate. After the batter reaches base or is out, the buttons are disabled. Palm's hardware buttons cannot be used to switch to other applications or record additional pitches once an at-bat is complete. Once you leave the GSP view, the Palm OS hardware buttons revert to their normal behavior.
Edit Note (Deluxe Version Only)

Allows you to enter any additional information to any at-bat during a game. The Edit note prompt can be found under the Options menu of the GSP view. When a note is added to an at-bat it can be viewed from the desktop version of the scorecard. On the scorecard itself a note symbol is displayed in the at-bat. When the at-bat is double clicked the note can be viewed.
Ending a Game

After you have scored an entire game, you may want to keep a permanent record of that score card. ScorePAD creates a permanent record the same way as other Palm OS applications; by performing a HotSync operation. If you are not familiar with this process, The Palm OS Handbook explains the HotSync process in detail.

Before you HotSync, ScorePAD contains three utilities that you might want to execute. ScorePAD allows you to do the following with a completed game:

- Save starting lineups
- Set the status of the game as complete
- Set the winning and losing pitchers
- Set the save pitcher if necessary
- Add game stats to RosterPAD stats

Saving the starting lineups

To save the starting lineup select **Save Lineup** from the **Options** menu of the ScoreCard view. ScorePAD will give you the opportunity to save the starting lineups of either or both teams.

Once you make your selection, ScorePAD instantly saves the lineup(s). ScorePAD saves the batting order and position of the starters even if you have substituted other players for the starters. ScorePAD will create RosterPAD entries for each player created in the Lineup view if they do not already exist.
Setting the game status to 'Complete'

To signal ScorePAD that you have completed a game, you must set the ending time of the game. If the game goes through the number of scheduled innings you specified in the Game Parameters dialog, ScorePAD will prompt you to set the ending time to the time when the game ending play occurs. If you answer "No" to that prompt or the game ends before the end of its scheduled end inning, select Game Setup from the Options menu of the ScoreCard view.

Touch the field next to End Time and ScorePAD will present you with a time selection dialog. The dialog will automatically set the end time as 3 hours past the begin time. If the game has just ended, touch the Now button to enter the current time. If you would like to set the time, touch the hours or minutes and use the up and down arrows to change them. Select the am or pm as appropriate.

Once you set an ending time for a game, the game is closed. ScorePAD will not allow you to add any more at-bats. You can change details about existing at-bats, game parameters, and lineup information.

If you want to reopen the game to change at-bats or add new at-bat, set the End Time field of the Game Setup view to In Progress.

Recording the Win, Loss, and Save

Select Win/Lose Pitcher from the Stats menu of the Scorecard view.

Only the pitchers of the winning team will appear in the Winning Pitcher list. Likewise, the pitchers for the losing team will appear in the Losing Pitchers list. Pitchers from the winning team will also appear in the Save Awarded list.

Select the winning, losing, and save pitchers as determined by the official scorer. Only select a save pitcher if the pitcher that finished the game entered the game in a save situation.
Marking save opportunity pitchers

Relief pitchers that entered the game under a save opportunity situation should be credited with a save opportunity if they leave the game or the game ends with that pitcher having lost the lead. ScorePAD automatically credits a Save Pitcher with a save opportunity. If, however, a relief pitcher enters the game in a save opportunity situation but blows the save, for whatever reason, you should credit that relief pitcher with a save opportunity.

To credit a pitcher with a save opportunity:

1. Select Edit Lineup from the Options menu of the ScoreCard view
2. Touch the player number of the pitcher
3. Select Edit player detail from the Player menu
4. When the player detail dialog appears with the pitcher's name, check the Save opportunity checkbox

Locking-in season stats

You can save the season statistics of the players of the current game. This feature attaches the season stats entering the game for each player to the game. This feature gives you three benefits:

- You can correct game event and re-update season statistics to RosterPAD as many times as you wish before you start the next game.
You can refer back to that game in the future and get a complete snapshot of each player's performance at that point in the season.

Locking in can also enable you to have season averages on your desktop box score.

To lock-in the current stats from RosterPAD, select Lock-in season stats from the Stats menu of the Score Card view. ScorePAD will give the opportunity to select either or both teams, or cancel the command all together. Once you select the team(s), ScorePAD will grab the current season statistics from RosterPAD for each player that participated in the game and attach them to that game.

After locking-in season statistics for a game, whenever you look at the game, ScorePAD will refer to the season statistics attached to that game and not the current RosterPAD season statistics. This feature gives you a statistical context for each game.

Removing locked-in stats from a game

If you decide you do not want season stats attached to a game, you can remove those stats. Select Release season stats from the Stats menu of the Score Card view.

**Updating statistics**

ScorePAD generates offensive and defensive statistics for each player that participates in a game. ScorePAD also generates pitching stats for each pitcher that participated in the game.

To add these statistics to the totals maintained by RosterPAD, select Update season stats from the Stats menu of the Score Card view. ScorePAD will take several seconds to calculate and transfer the batter and pitcher statistics to RosterPAD. ScorePAD will be ready to begin the next game using the updated stats.
You should execute the **Lock-in season stats** command before updating statistics. If the season statistics at the start of the game are locked-in, you can create and update season stats (including the statistics of current game) multiple times before you start a new game. If you have not locked-in season statistics, you can only update RosterPAD’s season statistics from the current game one time. This causes a problem if you made a scoring mistake or neglect to make a lineup change since you will then have to update RosterPAD’s stats manually.
Using Infrared with ScorePAD

You can transfer or beam lineups and games between infrared equipped Palm OS devices. This allows you to share games with other Palm OS users. For instance, if you arrive late at an ongoing game, you might ask another ScorePAD user to transfer his score sheet of the game to your device after the current at-bat.

Beaming represents a breakthrough in sharing scoring information. A full game with 9 innings of play including substitutions, batter stats, pitcher stats spray charts, box scores, umpires, and dates and times can be beamed from one Palm OS device to another in 10 seconds.

As ScorePAD becomes prevalent among team scorers, you will see coaches meeting at home plate with Palm OS devices and trading lineups via infrared.

Beaming games

To beam a game from one Palm OS device to another you must lineup the infrared ports of the devices.

On the sending device:

1. Open the ScorePAD game you wish to transfer
2. Select **Beam Game** from the **Options** menu of the Score Card view

On the receiving device:

1. You will be prompted to accept or reject the incoming game with the standard Palm OS Beam dialog. If you already have a copy of the game being beamed to your device, ScorePAD will prompt as to whether or not you want to replace the game already in ScorePAD with the incoming game, create a new copy of the game, or reject the game being beamed to you.
2. Once you accept the game, ScorePAD will open that game in the Score Card view. You may now HotSync the game to your desktop.

ScorePAD remembers everything about the game you have received. For instance, if the game is still in progress you can touch the Batter button and ScorePAD will take you to the at-bat of the next logical batter.

**Beaming lineups**

Beaming lineups works slightly different than beaming a game. The purpose of beaming lineups is for two scorers of opposing teams to exchange lineups. For that reason ScorePAD assumes that you have already created a game into which you want a beamed lineup to go or from which you want to beam a lineup to another scorer. If you want to receive both lineups from another scorer, have that scorer beam his entire game to you.

To beam a lineup you must lineup the infrared ports of the Palm OS devices and,

On the sending device:

1. Open the ScorePAD game containing the lineup you want to beam
2. Select the team whose lineup you want to beam
3. In the Score Card view, select **Beam Lineup** from the **Options** menu
4. ScorePAD will immediately beam the lineup of the selected team via the infrared port.

On the receiving device:

After receiving the beam lineup, ScorePAD prompts you as to whether or not you wish to receive the lineup into the current game, pick another game, or reject the lineup.
If you choose to receive the lineup into the current game, ScorePAD will find the team of the current game that matches the team of the beamed lineup. ScorePAD will then set the lineup for that team to the beamed lineup. If you choose to pick the game into which the received lineup will go, ScorePAD will allow you to pick the game and team using the following dialog:

To pick the game and team:

1. Select the **Home** or **Visitors** (ScorePAD will default to whichever the sender set the team)
2. Select game to which ScorePAD will set the lineup
3. Touch the **Receive** button to receive the lineup or touch the **Reject** button to reject the lineup.

Once you have accepted the beamed lineup, ScorePAD will restart and open the game to which you sent the lineup. After receiving a lineup or a game, ScorePAD treats that game or lineup as if it had originated on your device. You need not treat beamed games or lineups any differently than lineups or games that you created on your Palm device.
Reference Section
### Reference

#### At-bat result types

**Reach Base Types**

$x =$ defensive position 1-9

<table>
<thead>
<tr>
<th>Score Card Display</th>
<th>Graffiti Abbrev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base On Balls</td>
<td>BB</td>
</tr>
<tr>
<td>Single</td>
<td>1B</td>
</tr>
<tr>
<td>Double</td>
<td>2B</td>
</tr>
<tr>
<td>Triple</td>
<td>3B</td>
</tr>
<tr>
<td>Home Run</td>
<td>HR</td>
</tr>
<tr>
<td>Hit Batsman</td>
<td>HB</td>
</tr>
<tr>
<td>Fielders Choice</td>
<td>FCxx</td>
</tr>
<tr>
<td>Error</td>
<td>E</td>
</tr>
<tr>
<td>Sacrifice</td>
<td>SAC</td>
</tr>
<tr>
<td>Dropped 3rd Strike</td>
<td>Kd3</td>
</tr>
<tr>
<td>Defensive Interference</td>
<td>DI</td>
</tr>
<tr>
<td>Obstruction</td>
<td>OB</td>
</tr>
<tr>
<td>Sacrifice Fielder's Choice</td>
<td>FC</td>
</tr>
<tr>
<td>Sacrifice Error</td>
<td>E</td>
</tr>
<tr>
<td>Fielder's Choice Error</td>
<td>FC</td>
</tr>
<tr>
<td>Didn't See</td>
<td>??</td>
</tr>
<tr>
<td>Tie-breaker</td>
<td>TB</td>
</tr>
</tbody>
</table>

**Out Types - Batter**

$x =$ defensive positions 1-9

<table>
<thead>
<tr>
<th>Score Card Display</th>
<th>Graffiti Abbrev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strike Out</td>
<td>Kc or Ks</td>
</tr>
<tr>
<td>Ground Out</td>
<td>xx</td>
</tr>
<tr>
<td>Tag Out</td>
<td>Tx</td>
</tr>
<tr>
<td>Line Out</td>
<td>Lx</td>
</tr>
<tr>
<td>Fly Out</td>
<td>Fx</td>
</tr>
<tr>
<td>Pop Out</td>
<td>Px</td>
</tr>
<tr>
<td>Foul Out</td>
<td>fFx</td>
</tr>
<tr>
<td>Double Play</td>
<td>DP</td>
</tr>
<tr>
<td>Lineout Double Play</td>
<td>Lx</td>
</tr>
<tr>
<td>Reverse Force Double Play</td>
<td>DP</td>
</tr>
<tr>
<td>Triple Play</td>
<td>TP</td>
</tr>
</tbody>
</table>
Infield Fly Rule | IF | IF or IFx
Sacrifice Fly | SF | SF or SFx
Sacrifice Bunt | SB | SB
Bunt Foul 3rd Strike | Kf | KBF
Spectator Interference | Is | IS
Offensive Interference | Io | IO
Illegal Bat | IB | 
Out of Batter's Box | OBB | OBB
Basepath Violation | BV | BPV
Didn't see | ?? |

Out Types - Runner

Force
Thrown Out
Tagged Out
Picked Off
Caught Steal
Auto Appeal
Voice Appeal
Refused Score
Reverse Base
Basepath Violation
Passed Runner
Offensive Interference
Didn't See

Advance Runner

Batter
Error
Throw
Fielder's Choice
Steal
Indifference
Wild Pitch
Passed Ball
Balk
Caught Steal/Error
Defensive Interference
Defensive Obstruction
Umpire Interference
Runner Hit
 Didn't See
**Pitch Detail**  
*(ScorePAD Deluxe only)*

**Pitch Types**
- Fast Ball
- Slider
- Split Finger
- Curve
- Knuckle Ball
- Screw Ball

**Swing Types**
- No Swing
- Full
- Half
- Check
- Bunt
- Hit & Run

**Pitch Results**
- Ball
- Strike
- Foul
- Pick Off Attempt
- No Pitch

**Pitch Speed Range**
- 16 MPH - 110 MPH

---

**ScorePAD's MLB Team Abbreviations**

**American League**
- BAL Baltimore Orioles
- BOS Boston Red Sox
- ANA Anaheim Angels
- CLE Cleveland Indians
- CWS Chicago White Sox
- DET Detroit Tigers
- KC Kansas City Royals
- MIN Minnesota Twins
- NYY New York Yankees
- OAK Oakland Athletics
- SEA Seattle Mariners
- TAM Tampa Bay Devil Rays
- TEX Texas Rangers
- TOR Toronto Blue Jays

**National League**
- ARI Arizona Diamondbacks
- ATL Atlanta Braves
- CHI Chicago Cubs
- CIN Cincinnati Reds
- COL Colorado Rockies
- FLA Florida Marlins
- HOU Houston Astros
- LA Los Angeles Dodgers
- MIL Milwaukee Brewers
- MON Montreal Expos
- NYM New York Mets
- PHI Philadelphia Phillies
- PIT Pittsburgh Pirates
- SD San Diego Padres
- SF San Francisco Giants
- STL Saint Louis Cardinals
RosterPAD
**RosterPAD**

RosterPAD enables you to keep team, name, number, position offensive statistics, and other information about baseball players.

With RosterPAD you can:

- Quickly lookup or enter player information
- Accumulate and store season offensive and defensive statistics
- Accumulate and store pitcher statistics
- Display calculated season statistics
- Assign players to leagues and teams
- Sort players by team or by name
- Create and edit team leagues

To open RosterPAD:

1. Touch the or icon in the Graffiti area to open the Applications Launcher.
2. Touch the icon to open RosterPAD.
Getting Started With RosterPAD Players

A RosterPAD player entry stores player information. RosterPAD makes creating and editing player information simple.

Creating a RosterPAD Player

You can create RosterPAD players on your Palm device, or you can use the ScorePAD desktop software to create RosterPAD players and download the new players to your Palm device with the next HotSync operation.

To create a new RosterPAD player:

1. Start RosterPAD

2. Touch the New button to create the new player and display the Player Edit screen

3. Enter the last name of the player you want to add to RosterPAD.

4. Use the Next Field Graffiti stroke to move to the First Name field.

5. Enter the first name of the player.

6. Use the Next Field Graffiti stroke to move to the Team field. For Major League Baseball teams, you must enter a two or three letter team abbreviation. For example, for the Cincinnati Reds you would enter CIN. Check the Reference section in the ScorePAD Palm manual for a full list of Major League Baseball teams and abbreviations.
7. Touch the Position field. RosterPAD will display a list of recognized baseball defensive positions. Touch one of the positions in the list or <None> at the top of the list.

8. Touch the Number field. Use Graffiti to enter the player's jersey number.

9. Touch the Bat Order field. Pick from the list of batting order numbers. ScorePAD uses this number to assign starting lineup slots. ScorePAD updates this number whenever you use the Save Lineup utility.

10. Touch the Bats field. Pick from the list of batting hands; select Left, Right, or Switch. ScorePAD uses data in this field to set the batting hand in its GSP view. If a player is a switch hitter, ScorePAD Palm sets his batting hand to the opposite of the pitching hand of the pitcher for each at-bat.

11. Touch the Throws field. Pick from the list of throwing hands; select Left or Right.

12. The remainder of the fields are text fields. You may enter data in those fields if you like. The data in the remaining fields are not used by ScorePAD.

**Entering Batting Statistics**

Touch the Batter Stats button

Once in the Batter Stats dialog, touch the desired field, then enter the statistic for that field using Graffiti. If you use MLBStats, it will fill in all of the data on this dialog whenever you update. Additionally, ScorePAD updates statistics on
this dialog whenever you selection **Update Season Stats** from its Stats menu.

Touch the **Done** button when you have entered all statistics. If you wish not to keep the statistics you have entered or changed, touch the **Cancel** button.

### Editing a RosterPAD Player

After you create a RosterPAD player, you can update or add information to it at any time.

**To edit a RosterPAD entry:**

1. Touch the RosterPAD entry that you want to change. This will display the Player View screen for that entry.

2. Touch the **Edit** button (or anywhere on the screen) to display the Player Edit screen.

3. Touch any text field (Last name, First name, Team, Number) and enter or change the information; or touch a selectable field (Position, Bat Order, etc.) and make a new selection.

4. After you finish, touch the **Done** button to return to the Player List screen.

### Deleting a RosterPAD Entry

There are two ways to delete a player: Use the Menu Commands (described in the "Record Menu" section of this chapter, or use the **Delete** button on the Player Edit view.

To delete a player in the Player Edit view:
1. Touch the **Delete** button. RosterPAD will display the Delete Player Alert.

2. Touch the **OK** button to confirm that you want to delete the player.

**Working with RosterPAD Players**

RosterPAD allows you to find Players, group them by leagues, and display players by name or team.

**Looking Up Players**

When working with RosterPAD, the scroll buttons on the front panel of your Palm OS device make it easy to navigate among player entries. In the Player List view the scroll buttons move up or down an entire screen of players.

You can also use the Player List Look Up feature to quickly scroll to any player.

**To look up a RosterPAD player:**

1. Display the Player List view.

2. Enter the first letter(s) of the last name of the player you want to find. As you enter the letters RosterPAD will come closer and closer to selecting the name you want. If the players are sorted by team, enter the team abbreviation to scroll to that team.

3. Touch any player to view his record, or use the carriage return stroke to view the selected player.
Sorting by Player Name or Team

You can sort players in RosterPAD by Team and Last Name, or by Last Name and First Name. These settings do not change your RosterPAD data; they offer you a different view of the data.

To sort players in the Player List view:

1. Display the Player List view

2. Touch the or icon to open the RosterPAD menus.

3. Touch Preferences... from the Options menu to the RosterPAD Preferences dialog.

4. Touch the Team, Last Name setting to sort by Team and Last Name.

5. Touch the OK button to display the Player List view with all player names sorted by Team.
Beaming RosterPAD Players

Beaming allows you to transfer players and their statistics from one Palm device to another via their infrared ports. You can beam RosterPAD players, teams, and leagues. Beamed players will replace players you already have in RosterPAD if their teams, jersey numbers, and last names match.

To perform any beaming operation, you must lineup the infrared ports of the sending and receiving Palm devices. The infrared port is located at the top of Palm devices on the left side of Handspring Visor devices.

**To beam a player you must:**

1. Select a player from the Player List view.
2. Select Beam Player from the Record menu of the Player View. You may also select Beam Player from the Record menu of the Player Edit view.

**To beam a team you must:**

1. Select a player from the Player List view that belongs to the team you wish to beam.
2. Select Beam Team from the Record menu. You may also select Beam Team from the Record menus of Player and Player Edit views.

**To beam a league you must:**

1. Select the league you wish to beam from the Category List while in the Player List view.
2. Select Beam League from the Record menu. You may also select Beam League from the Record menus of Player and Player Edit views.
RosterPAD Menu Commands

RosterPAD includes menu commands to make routine file and editing commands quick and easy. This sections details RosterPAD menu commands.

Record Menu

There are a couple ways to access the Record menu in RosterPAD. One way is to select any player on a team and then select the menu icon on your handheld. The second way to access the Record menu is selecting the menu icon while looking at the entire roster. When you select the Record menu, its commands appear on the screen.

Delete Record... Opens an alert dialog prompting you to confirm deletion of the current entry. Touch the OK button to delete the current player from RosterPAD, or touch Cancel to close the alert dialog and keep the entry.

Delete Team Opens an alert dialog prompting you to confirm the deletion of the entire team of the current player. Touch OK to delete the current team, or Touch Cancel to keep the current team. Checking the "Don't delete team on desktop" causes RosterPAD to completely remove the players from your Palm without instructions to delete them from your desktop.

Attach Note Opens the RosterPAD Note dialog where you can create a Note for the current player.

Delete Note... Opens an alert dialog prompting you to confirm deletion of the Note attached to the current player.
Touch the **OK** button to delete the Note, or touch the **Cancel** button to close the alert dialog and keep the note.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero Player Stats</td>
<td>Sets all player offensive and defensive statistics to zero.</td>
</tr>
<tr>
<td>Zero Pitcher Stats</td>
<td>Sets all pitcher statistics to zero.</td>
</tr>
<tr>
<td>Beam League</td>
<td>Beams the current league using infrared</td>
</tr>
<tr>
<td>Beam Team</td>
<td>Beams the current team using infrared</td>
</tr>
<tr>
<td>Beam Player</td>
<td>Beams the current player using infrared</td>
</tr>
<tr>
<td>Send League</td>
<td>Sends the current league using bluetooth</td>
</tr>
<tr>
<td>Send Team</td>
<td>Sends the current team using bluetooth</td>
</tr>
<tr>
<td>Send Player</td>
<td>Sends the current player using bluetooth</td>
</tr>
</tbody>
</table>
Options Menu

When you select the Options menu, its commands appear on the screen.

Preferences

Opens the Preferences dialog.

Select Last Name, First Name to sort players by last name then first name. Select Team, Last Name to sort players by team then last name. Touch OK to execute sort or Cancel to abandon sort. Both buttons close the dialog. If you choose to sort records, depending on the number of players you have in RosterPAD, the sort can take several seconds.

When checked, the Backup RosterPAD database checkbox causes the HotSync process to backup the RosterPAD database whenever you change it. If your HotSync process takes too long, uncheck this box. Make sure you backup the RosterPAD database periodically.

About RosterPAD

Shows version information for the RosterPAD application.
MLB Stats
**MLBStats**

MLBStats enables you to keep statistics up-to-date for any or all Major League Baseball teams. Our website is updated everyday of the Major League Baseball season to make all player stats available at a touch of your finger.

With MLBStats, you can use your Palm device and a standard Internet connection to automatically update the statistics of any set of Major League Baseball teams you select.

To use MLBStats you must have a Palm Modem or establish an Internet connection through a serial TCP/IP connection from a Window NT Workstation or Server.

MLBStats will:

- Connect to the Internet
- Allow you to select teams you want to update
- Update all players’ statistics on the teams you select

Before starting MLBStats, you must use Palm Network Preferences to setup your Internet service. MLBStats immediately connects to the Internet service that you setup and select in Network Preferences. Check the Palm Handbook for detail on how to setup an Internet service. MLBStats can also use the wireless connection on Palm VII devices.

To open MLB Stats:

1. Touch the or icon in the Graffiti area to open the Application Launcher.
2. Touch the icon to open MLBStats.
Updating Player Statistics

After starting MLBStats, unless you have used the Network Preferences dialog to connect to the Internet and currently have an active connection, MLBStats will establish an Internet connection using your Palm Modem. MLBStats will then present the MLBStats main view.

MLBStats Main View

When you successfully connect to the Internet, the Status will read Connected. If, for some reason, you did not connect successfully, the Status will read Not Connected.

Adding teams to the list to update

To select the teams you want to update:

1. Touch the a team in the Teams list.
2. Touch the button to add the team to the Selected Teams list.
3. Repeat steps 1 & 2 until you have selected all teams you want to update.
4. Touch the Begin update button to start team updates.

MLBStats will update its status as it connects, and then updates each team. After MLBStats completes its update cycle, the batter stats for each player will contain updated statistics.
To select all Major League Baseball teams:

1. Touch the to add all teams to the Selected teams list

2. Touch the Begin update button to start team updates.

After updating is completed, the Status line will show All teams updated.
When you exit MLBStats, it will automatically terminate its Internet connection if MLBStats made the connection. If the connection was established outside of MLBStats, upon exit, MLBStats will leave the Internet connection intact.

Removing teams from the list to update

To deselect the teams you don't want to update:

1. Touch the team in the Selected teams list.

2. Touch the button to remove the team from the Selected Teams list

3. Repeat steps 1 & 2 until you have removed all of the teams you don't to update.

Use the button to deselect all teams.

MLBStats subscription

MLBStats is offered on a yearly subscription basis. In order to gain the benefits of MLBStats, you must subscribe to this service each season. MLBStats gives you access to player offensive and defensive statistics everyday of the season by 10:00 A.M. Eastern US time.

Once you subscribe, you can download stats with the MLBStats application as many times as you wish during the season. You may also take advantage of MLBStats download when they become available in Major League baseball parks.

ScorePAD Desktop
ScorePAD Desktop

ScorePAD Desktop is a Windows-based boxscore and player statistics viewing and reporting system. ScorePAD Desktop also allows you to create and edit leagues and team rosters. After you score baseball games on your Palm device and synchronize with your desktop, ScorePAD Desktop gives you access to those games.

With ScorePAD Desktop you can:

- View score cards of games scored on your handheld device
- Print detailed score cards of games scored
- Print a statistical summary for each team
- View and print compiled statistics from games scored
- View and print year-to-date statistics from RosterPAD
- Create, edit, and print team rosters

ScorePAD Desktop acts as an archive for the games you score on your Palm device. Palm devices are the perfect platform for scoring baseball games because of their size, cost, and touch-screen input. However, storage and screen size limitation make the Palm less that desirable for analyzing game score sheets and statistics. ScorePAD's Desktop overcomes these limitations giving you the best of both worlds. ScorePAD Desktop makes use of the nearly unlimited space and substantial viewing area of desktop computers for viewing and reporting on games scored on the Palm.

ScorePAD Desktop takes advantage of desktop computer power allowing you to analyze games, player statistics, and hitting charts.

ScorePAD Desktop is divided into four major views: ScoreCard View, Roster View, Stats View, and Spray Chart View.

**ScoreCard view Features**
- Displays score cards ScorePAD Palm games
- Displays pitching charts of games
- Exports game statistics to a text file
- Exports entire games to a file
- Prints graphic score sheets
- Prints graphic pitching charts
- Prints detailed game reports
- Prints box score reports
- Displays complete lineup information
- Edits game parameters
- Edits lineups
- Edits at-bat details
Roster view
Features
Allows entry and editing of team rosters and statistics
Prints team rosters
Allows entry and editing of leagues
Allows updating of MLB player statistics (for MLBStats subscribers)
Exports players and season statistics to text files

Stats view
Features
Displays statistics compiled from games scored
Displays year-to-date statistics from RosterPAD
Allows selection of statistics displayed and printed
Allows sorting of statistics by any category
Prints statistics from each sub-view
Exports statistics to text files
Updates RosterPAD season statistics

Spray chart view
Features
Displays balls put in play by hitters
Allows selection of hitters and pitchers
Prints spray charts

ScoreCard view
Spray chart view
Scorecard View

After scoring a baseball game with ScorePAD on your Palm device and synchronizing with your desktop, you can view the game in the Score Card view. This view displays both visitor and home team score cards. You can click on any at-bat to see its detail. The at-bat detail window shows at-bat information including the at-bat result, balls and strikes, and base advances. You can also print both score cards from the Score Card view.

The Score Card view allows you to make changes to lineups and at-bat detail, but you must change most at-bat scoring information on your handheld. All game data synchronized to the desktop contributes to the season statistics generated in the Stats view.

Loading a game

ScorePAD Desktop uses a different tool bar for each view. In the Scorecard view, the toolbar allows you to select games by RosterPAD league.

Select the league of either team involved in one or more games. ScorePAD then creates a list from your database of all of the games you have scored for teams in that league. Those game will appear in the Games list.

Select the game. Games are sorted in chronological order starting with the most recent game.
The Scorecard

Sample ScorePAD Desktop Scorecard

The Scorecard view displays both of the score cards of each game. Each score card displays the following information:

- Team name and score in game
- Player information
- Results of all at-bats for the team
- Detail of a specific at-bat
- Pitchers and their statistics for the game

The Scorecard view displays the team name and score at the top of the score card. The player information section of the score card occupies the first four columns. Player information columns contain:

- Player number
- Player name
- Player defensive position
- Inning player left the game (if applicable)

The at-bat results grid displays at-bat results. The grid uses the same nomenclature and graphic representation as ScorePAD for Palm devices. The grid displays base advances, and runs scored in different colors.
Looking at an at-bat's detail

You may want to examine in detail a particular at-bat. To do this, you click on any at-bat square in a score card. The detail of that at-bat will instantly display to the right of the score card to which it belongs.

The At-bat Detail square contains:

- Player name & number
- Pitcher name and throwing hand
- Inning and at-bat number during inning
- At-bat result
- Inning out number
- Positions involved in putout
- Out result
- Base advances and reasons
- Pitch sequence
- Final ball & strike count

You can select and examine any at-bat you want on either scorecard. When you print the score sheets, information in the At-bat Detail square will be printed for each at-bat except player name and number, pitcher name and number, and pitch sequence.

The Detail score sheet mode

In the Detail score sheet mode, you can view the detail of each at-bat within the scoring square of that at-bat rather than in the at-bat detail square off to the right of the score sheet.

You can also see more information when you put the Scorecard view in the Detail mode.
In Detail mode you can see:

- Inning totals for Runs, Hits, Errors, and Left On-base
- Up to 7 substitutions per batting slot

You can put the Scorecard view in Detailed mode using any of the following methods:

1. Select Detailed in the Combo box on the toolbar
2. Press the + button on the toolbar to show four or more substitutions
3. Select 4 or more substitutions in the Preferences dialog
4. Select Detailed as the score sheet type in the Preferences dialog
Printing the score sheets

To print the score sheets of a game you have loaded in the Score Card view, select File Print... from the menu.

When the Print dialog appears the Pages fields in the Print Range section from: and to: default to 1 and 2 respectively. The visitor score card is page 1 and the home score card is page 2.

- If you want to print both score cards, use the default.
- If you want to print only the home team, change the from: field's value to 2 so that both the from: and to: fields of Pages have a value of 2.
- If you want to print only the visitor score card, change the to: field's value to 1 so that both the from: and to: fields of Pages have a value of 1.

You can preview before printing score sheets. Select Print Preview from the File menu to preview the output of score sheets. Print preview allows you to look at both pages at once or one at a time before you print them. You can zoom in and out if you want to see more detail.

Printed score sheet detail

Printed score sheets have the same general structure of the score sheets displayed in the Score Card view, however, printed score sheet contain the at-bat detail in each of the at-bat squares. The printed score sheet also contains:

- Player stats
- Inning stats
- Pitcher stats
- Game logistics
- Line score

Printing a box score report

To print the box score of a game you have loaded in the Score Card view, select Print box score... from the File menu. When the Print dialog appears, press the Print menu. ScorePAD will print a box score report.

The box score report contains the following information on an individual game:

- Batting statistics for each player in the lineup
- Notable batting stats for individuals such as Extra base hits, RBI, Ground into Double-plays and total Team Left on Base
Sample Printed Score Sheet
Notable base-running stats for individuals: Stolen bases, Caught Steals
Notable fielding for individuals: Errors & Double Plays
Pitching statistics for each pitcher that faced one or more batters
Notable pitching stats for individual pitchers: Wild pitches, Ground ball outs, Fly ball outs, number of batters faced
Game logistics: Game duration, weather, and officials

Creating a box score web page

If you want to display the results to a game on the web, you can create an HTML file that contains all of the game information contained on the printed Box Score report.

To create an HTML Box Score page:

1. Load a game
2. Select Create Box Score web page.. from the File menu
3. ScorePAD creates a default file name (ex.:ATL_AT_NYM_09_22_2002.htm)
4. Change the default file name and/or directory if you want
5. Click the Open button to create the HTML file

You can copy the HTML file created by ScorePAD directly to your web site and link it into your existing site. You can also use an HTML editor to make any cosmetic or content changes.

Exporting game statistics

ScorePAD Desktop allows you to export the game statistics to a spreadsheet compatible file format. This will allow you to use game statistics generated by ScorePAD with other baseball statistics programs or spreadsheets. The format of this game statistics file is in the Reference chapter at the end of this manual. You can export any loaded game by selecting File Export game statistics. ScorePAD generates a file name that contains both teams and the date of the game (ex: ATL_AT_CIN_08_04_2002.asg.)

Exporting games for sharing

With ScorePAD, you can share all of the detail of an entire game with other ScorePAD users. To share a game, you must export that game to a file. The file format of ScorePAD games is proprietary and used only by ScorePAD Desktop. Once a game is exported, you can:

1. Post the game file on a website
2. Email it directly to other ScorePAD users
3. Copy it to a diskette and manually transport it to another computer
4. Post it on an organizations network

To export a game from ScorePAD Desktop

1. Load the game
2. Select Export Game... from the File menu
3. Change the default file name and/or directory if you want
4. Press the Save button

ScorePAD uses the file type SXG for exported ScorePAD games.

**Importing a ScorePAD game**

To import a ScorePAD game from a SXG file:

1. Select Import Game... from the File menu
2. Browse to find the file in the Open dialog
3. Press the Open button

ScorePAD will add the imported game to your ScorePAD database of games.

Imported game are used just as games you scored yourself. You can print them, export them, and use the stats generated by them to derive stats sheets.

**Editing game parameters**

You can view and edit game parameters in the ScoreCard view. Select Game Parameters from the Edit menu to show the Game Parameters dialog.
This dialog allows you to change the following game parameters for each team:

**League** - The team's league
**Players** - The number of players that will be used in the lineup
**Standing** - The numeric standing of the team within its conference or league. Teams can be placed from 1st to 30th.
**Games from 1st** - The number of games out of first place. Enter any number of games from first.
**Scheduled Innings** - The number of innings for which the game was scheduled

You can also select the following parameters for the game:

**Game Type** - The time, relative to the season this game was played. Valid Game Types are: Season, Preseason, Division series, League championship, World championship, District tournament, Sub-state tournament, State tournament, Regional tournament, National tournament, Exhibition, & Scrimmage
**Series number** - A unique series number that allows ScorePAD to categorize statistics by series.
**Game date** - Date on which game was played
**Start** - Starting time of game
**End** - Ending time of game (including delay)
**Delay hours** - Number of total hours of delay during game time
**Delay minutes** - Number of total minutes of delay
Changing ScoreCard View Preferences

You can change the following ScoreCard view preferences:

- Date range of games ScoreCard view Games list
- Preference to force all Palm games to desktop
- Preference to include season ERA and/or batting averages on box score report
- Batting statistics included on score sheets
- Pitching statistics shown below score sheets
- Score sheet display mode

To invoke the ScoreCard view Preferences dialog, select Preferences from the File menu of the ScoreCard view.

Changing date range for the Games list

Change the Start date and/or End date of the dialog. Press OK to set the new dates.

ScorePAD will reload the list of games based on the date range you specify. When looking for a game that you have HotSync'd from the Palm, make sure that game is within the date range you have set. If the game is not within the date range, it will not show in the games list even though ScorePAD successfully added it to the game database.
Forcing games to transfer from Palm

If you check the Make Sure PC contains all games... check box, ScorePAD's synchronization conduit will check each game on the Palm during the next HotSync operation and add any game not already copied to the desktop. This option will slow down the next HotSync operation. Only if you have more than 20 games on your Palm will the additional time be noticeable.

During normal HotSync operation, ScorePAD's conduit only checks games that have been created or changed since the last HotSync.

Including ERA and Batting average on Box Score

You can also include the season batting averages and season earned run averages of pitchers on the box score report by checking the appropriate boxes on the Preferences dialog. You must lock-in season statistics on the Palm before you transfer games if you want to show season statistics on the box score report.

Changing the score sheet display preferences

You can change the scoresheet display between Compact and Detailed. In Compact mode, the score sheet's square only contain summary information about the at-bat. In Detailed mode, each square contains all of the at-bats detail including balls and strikes and the place that ball was put it play, if applicable.

You can change the number of substitutions each lineup slot shows on the on-screen score sheet. If you select 4 or more substitutions, the score sheet will automatically change to Detailed.

Clicking the Batting statistics... button allows you to change the batting statistics displayed on the both Compact and Detailed score sheets. The statistics you choose will also print on the printed score sheet.

Clicking the Pitching statistics... button allows you to change the pitching statistics displayed at the bottom of the ScoreCard view. Like the batting statistics, the pitching statistics print on the printed score sheet.

You can turn off batting statistics on the ScoreCard view by un-checking the Show statistics on score sheet checkbox.
**Editing lineup players**

You can view and edit the lineup for either team. The Lineup Players dialog allows you to edit the lineup by adding, deleting, or changing information about any player in the lineup. Double-click any lineup player on the ScoreCard view to display the Lineup Players dialog.

*Lineup Players Dialog*

The Lineup Players dialog allows you to see and edit the following information about each player in the lineup:

- **Order** - Batting order number
- **#** - Uniform number
- **Last** - Last name
- **First** - First name
- **Pos** - Defensive position
- **Start** - Inning player entered the game
- **End** - Inning player left the game
- **End Btr** - If player left the game while team was on defense, the number of the complete batters in the inning when the player left the game

**To edit information about a lineup player:**

- Double-click the player
- Change any of the at-bat information
- Press OK to dismiss the Edit Lineup Player dialog
To add a player to the lineup:

Press the **Add Player...** button
Fill in all of the player information
Press **OK** to add the player

To delete a lineup player:

Double-click any player in the lineup
When the Edit Lineup Player dialog appears, press the **Delete** key
Press **Yes** when the delete confirmation dialog appears

When you finish editing the lineup, press **OK** to dismiss the Lineup Players dialog. Be careful when editing the lineup. You should not remove players from the lineup that have plate appearances or faced batters as a pitcher. You should not add players to the lineup that did not actually get placed in the lineup for that game.
Changing at-bat details

Although you cannot score a game or change balls and strikes for an at-bat, you can change detail about an at-bat on your desktop.

Edit at-bat detail dialog

In the Edit at-bat detail dialog, you can change:

- Batter
- Pitcher
- A second pitcher in case a change was made during the at-bat
- What pitch the second player entered the game
- Pinch runner
- Batting hand during at-bat
- The number of the at-bat in the inning
- Assists and putout
- RBI flag
- Earned run flag
- Result of at-bat
- Number of out in inning
- The at-bat during which the out was made
To change an at-bats detail:

1. Double-click any at-bat on a score sheet
2. Edit any at-bat detail
3. Press OK to save the changes

Deleting a game

You can delete any game in ScorePAD by loading the game and selecting File → Delete Game. Once you delete a game, you cannot recover that game. Before you respond to the confirmation prompt, be sure that you want to delete the game that you have loaded.

Deleting multiple games

To delete more than one game at a time:

1. Select Delete games... from the File menu
2. The Delete Game dialog will appear
3. Click the left-most column change a game to from Keep to Delete
4. If you make a mistake, click again to change from Delete to Keep

When you press OK, all games marked Delete, will be deleted. You will have a chance to confirm your decision to delete only once.
Sending games down to the Palm

With ScorePAD, you can send games from ScorePAD’s Desktop database to the Palm. If you receive a SXG file and import that game into your database, you can also send the same game to your Palm. Additionally, if you delete a game from your Palm or replace your Palm hardware, you might want to send games to your Palm.

To send games to your Palm:

Select Send games to Palm... from the File menu
The Download Games dialog will appear
Click the Send column of each game you want to send
The Send status of each game will change from No to Yes after you click
When you click the OK button, ScorePAD will mark each of the games you selected for sending during the next HotSync operation.

Examining pitching sequences

The ScoreCard view allows you to examine and print pitch charts. If you chart pitches during games you score, you can examine and print those charts in the ScoreCard view.

The “Home team pitch sequence” and “Visitor team pitch sequence” tabs allow you to display and print the pitch sequences of each at-bat in the subviews.

The first square of the sequence shows the match-up. It includes the following information:

- Batter’s name and number
- Inning and batter in inning
- Batter’s batting hand
- Pitcher’s name and number
- Pitcher’s throwing hand

The pitch sequence charts display the following for each pitch:

- Pitch location
- Pitch type
- Count before pitch
- Pitch result
- Swing type

139
The final square is a graphic of the at-bat square from the score sheet.

Pitch chart example

To access the pitching charts for a game, load the game and select either the "Home team pitch sequence" tab or the "Visitor team pitch sequence" tab in the upper right-hand corner of the ScoreCard view.

For details on how to record pitch detail, read the "Pitch Charting" section of the chapter "Scoring an at-bat" in this manual.

Moving to other views

You can select other ScorePAD Desktop views from the view menu. Select any of the following menu items from the View menu to move to other views:

- **Roster** moves you to the Roster view.
- **Team Stats** moves you to the Stats view.
- **Spray chart** moves you to the Spray chart view.
RosterPAD View

The RosterPAD view provides desktop maintenance of the ScorePAD’s team roster database. The RosterPAD view is the desktop companion of the RosterPAD for Palm OS. If RosterPAD looks familiar, it should. RosterPAD was designed to look and work like the address book in the Palm Desktop. This design decision allows you to remain in familiar territory and hopefully provide a lower learning curve for using the RosterPAD view.

In the RosterPAD view you can:

- Add new players
- Edit existing players and their statistics
- Delete players and their statistics
- Create and edit team information
- Cut, copy, and paste players using the Windows clipboard
- Import players and statistics from text files
- Export players and statistics to text files
- Create, edit and delete RosterPAD leagues
- Move players between RosterPAD leagues
- Update Major League Baseball rosters and player statistics

RosterPAD allows up to 15 leagues. To move to the RosterPAD view, select Roster from the View menu.
Adding players

To add players:

1. Click the New button in the RosterPAD view.
2. Select which league to put the player in.
3. Type first name last name, team, player number in the appropriate boxes of the New player dialog.
4. Select proper position, batting and throwing hands
5. If this player routinely starts games, select the spot of the batting order in which he will normally appear.
6. Click the OK button when you have finished editing the record.

You can also add address information and notes:

To add address information:

1. Click on the Address Tab
2. Add address, city, state and zip, and phone

To add notes:

1. Click on the Note Tab
2. Type in any free form note
Player statistics:

1. Click on the Stats Tab
2. Enter player season-to-date offensive and defensive stats

Team information:

1. Click the Team Tab
2. Enter team information

The team tab is unique in that the information entered under the team tab is shared between player of the same team.

Changing player info

Double-click the record in the player list or click on the desired player in the player list and click the Edit button.

From the Player Tab:

Edit information in the Last Name, First Name, and Team boxes.

Click the Position, Batting Hand, Batting Order, or Throwing Hand boxes and select new values.

Click the League box and assign the player to a league.

From the Address tab:

Change address information in the appropriate boxes.

From the Note tab:

Type any additional information in the form of free-form text.

From the Player Stats tab:

Change a player’s offensive and defensive season-to-date statistics

From the Pitcher Stats tab:

Change a player’s season-to-date pitching statistics.
Sorting players

1. Click the List By... button in the RosterPAD view.
2. Select Last Name, First Name to sort players by player name or, select Team, Last Name to sort players by team.
3. Click the OK button to close the dialog and initiate the sort
4. Click the Cancel button to leave the record sorted in the current order.

Deleting players

Select the players you want to delete:

1. Click on one player or,
2. Click on the starting player, hold down the shift key and click on the last player or,
3. Hold down the control key and click on each player you wish to delete.

Press the Del key.

Answer yes to the Delete Confirmation dialog.

Moving players among leagues

You can move one or more players to from one league to another. To move players to another league you must:

1. Select the players you want to move
2. Select Change League from the Edit menu.
3. Select the new league from the Change League dialog

Printing players

Select Print from the File menu to print all of the player records or the selected records in their current sort order.
Exporting and importing players

You can export players from the Roster database and import players into the Roster database. Of course, any players you add to the database will be automatically transferred to your Palm computer during the next HotSync operation.

**To export players from the RosterPAD view:**

1. Select the players you wish to export in the Roster view player list.
2. Select **Export players** from the **File menu**.
3. An **Open dialog** will appear with the default file name of SPPlayers.SPP
4. Enter a new file name, if you desire.
5. Press the **Open** button to export the selected players

**To import players into the RosterPAD view:**

1. Select **Import players** from the **File menu**.
2. Enter a file name or press the **Browse** button and select a file.
3. RosterPAD will import the files.

RosterPAD’s import utility requires that fields be in the order specified in the File Formats chapter of this manual. You do not have to include all RosterPAD fields, however Last Name, First Name, League, Team, and Player Number are required.

Using the clipboard with the RosterPAD view

You can cut, copy, and paste RosterPAD records using the Windows clipboard. This allows you to quickly move player information and year-to-date statistics from ScorePAD to other applications like spreadsheets, word processors, and databases management system. You can also use cut and paste to move players from one league to another.

**To cut players from the RosterPAD view:**

1. Select the players you want to cut.
2. Select **Cut** from the Edit menu or press **Ctrl-X**.

3. The deleted players and their statistics are now in the Windows clipboard. You can now paste them back into the RosterPAD view or into other applications.

**To copy players in the RosterPAD view:**

1. Select the players you want to copy

2. Select **Copy** from the **Edit** menu or press **Ctrl-C**

The selected players and their statistics are now in the Windows clipboard. You can now paste them into other leagues in the RosterPAD view or into other applications.

**To paste players into the RosterPAD view:**

1. Copy players to the Windows clipboard. You copy from the RosterPAD view of ScorePAD or another application. If you copy from another application, you must arrange fields in the order specified in the File Formats chapter of this manual. You do not have to include all RosterPAD fields, however Last Name, First Name, League, Team, and Player Number are required.

2. Select **Paste** from the Edit menu or press **Ctrl-P**.

You can also select all of the player in the current league. Select **Select All** from the **Edit** menu or press **Ctrl-A**.
Stats View

The Stats view of ScorePAD offers a statistical summary of player performance by compiling the statistics of all games contained in ScorePAD Desktop's database. This view can also display year-to-date statistics from RosterPAD data.

With the Stats View you can:

- Display offensive and defensive season stats for each player
- Display day-by-day offensive and defensive statistics for each player
- Display season pitching statistics for each pitcher
- Display day-by-day player and team pitching statistics
- Display day-by-day home runs and home runs allowed
- Print stats sheets
- Export statistics to text files
Create web pages from statistics subviews
Configure subview statistics content and order
Update RosterPAD season statistics from games scored

The Stats view has two modes:

1. Roster Data mode loads players and pitchers totals from the Roster view. The Roster Data mode includes team batting and pitching statistics.

2. Scored Games mode compiles player and pitcher totals from game scored in ScorePAD.

You can select any subview at anytime by selecting one of the tabs at the bottom of the Stats view. The tabs are:

1. Team batting Season batting and defensive statistics
2. Day-by-Day Batting Day-by-day batting and defensive statistics
3. Home Runs Day-by-day home runs and home runs allowed
4. Team Pitching Season pitching statistics
5. Day-by-Day Pitching Day-by-day pitching statistics
6. Defense Detailed defensive statistics
7. Games Day-by-day game outcomes

With each subview you can:

- Configure subview statistics content and order
- Sort statistics by any category by clicking the column heading
- Print the statistics as they are sorted
- Copy statistics to clipboard
- Display statistics by date range
Loading a team

To load a team you must select the league of the team you want to load from the league list toolbar.

Then select the team you want to load from the team list on the toolbar.

Once you select a league and a team, ScorePAD searches its desktop database and compiles the stats from all of the games in which each player of the selected team participated. ScorePAD then displays the totals for each player in the stats view.

Selecting a date range

You can select a date range for statistics you want ScorePAD to display in this view. To select a date range you must use the tool bar and select a start date and an end date. You can change either date or both dates by editing the date text or selecting the down arrow and picking a new date from the pop-up calendar. Once you select a new date, all statistics will reload and recalculate.
Displaying RosterPAD statistics

In addition to displaying statistics compiled from games scored, you can also display year-to-date statistics stored in RosterPAD. To display RosterPAD statistics, select Roster Data from toolbar.

Since these statistics are totals, you won't have any day-by-day batting, pitching, or home run statistics so those tabs disappear when you select RosterPAD Stats from the toolbar.

Printing stats sheets

To print a stats sheet on a team:

1. Load the team.
2. Select the desired subview
3. Select Print from the File menu.

ScorePAD will print stats subview in the same format that it appears on the screen.

Configuring subviews

You can configure the content and order of statistics displayed on the Season Batting, Season Pitching, Day-By-Day Batting, Day-By-Day Pitching, and Defense subviews. ScorePAD has a convenient dialog that allows you to configure these subviews.

Select Select Stats from the Edit menu in the Stats view to display the Statistics Selection dialog. This view is composed the following:

Statistics - List of statistics available but not displayed on the subview
Selected statistics - List of statistics to be displayed on the subview
Fixed columns - number of columns that do not scroll horizontally
Each subview contained a default set of statistics when you installed ScorePAD. You can add, remove, or reorder statistics for each subview.

To add a new statistic:

1. Select the place in the Selected statistics list where you want the new statistic to appear.
2. Select the statistic you want to add from the Statistics list.
3. Press the > button to add the statistic.
4. You can also double-click members of the Statistics list to add them to the Selected statistics list.

Any statistic you add to the Selected statistics list will be removed from the Statistics list.
To remove a statistic:

Select the statistic you wish to move in the Selected statistics list.
Press the < button
You can also double-click any member of the Selected statistics list to remove it.

All statistics removed from the Selected statistics list will be added to the Statistics list.

To reorder selected statistics:

Select the statistic in the Selected statistics list you want to reorder.

Press the Move up button to move the statistic up in the order or press the Move down button to move the statistic down in the order.

To change the number of fixed columns:

Click on the down arrow of the fixed column combo-box

Select the number of fixed column to which you wish to change.

You can change the number of fixed columns to values from 0 to 10. Fixed columns will be the left-most columns of the subview. Fixed columns will not scroll when you scroll horizontally in the subview. Additionally, fixed columns will not copy when you copy statistics to the Windows clipboard.

Subview statistics content and order are preserved for exporting, web page creation, printing, and clipboard copying.

Copying statistics to the clipboard

You can copy statistics from any subview to the Windows clipboard. This allows you to paste this data to spreadsheets, word processors, and other applications that retrieve data from the clipboard.

To copy data to the clipboard, select any combinations of columns and rows of data in a subview then select Edit Copy. This will place the selected data on the Windows clipboard. You can then switch to another application and paste the data. This function works very well with spreadsheets and graphing programs.
Exporting statistics

You can export statistics from the batting and pitching subviews of the Stats view. When you export statistics, ScorePAD creates a file containing all of the data on the subviews you select. Each included subview will be in a separate file. Each data element will be separated by separator you specify and each row of data will be terminated with a carriage return followed by a line feed (CRLF).

To export data perform the following steps:

Select the subview from which you want to export data
Re-configure the content and order of the data by selecting **Edit Select Stats...**, if necessary
Select **File Export statistics...**
Edit the path, file name prefix, separator, and subviews for which you want file generated in the **Statistics export specifications** dialog.
Press the Export files button.

ScorePAD will create the following files (assuming you kept the PlayerStats file prefix):

- PlayerStats.txt  Team batting subview statistics
- PlayerStatsPitcher.txt  Team pitching subview
- PlayerStats_DBD10Jones__C.txt  Day-by-day batting subview (one file for each player)
- PlayerStatsPitcher_PDBD29Miller__J.txt  Day-by-day pitching subview (one file for each pitcher)

Changing export settings

You can change export setting before you begin an export or during the export operation. To change the export settings before you next export, select **File**
Export settings... The Statistics export specifications dialog will appear. In this dialog you can select the subviews for which you want to create export files. You can also specify the export file directory, prefix, and field delimiter.

Creating Web pages from the Stats view

You can create web pages from each batting and pitching subviews. These web pages will contain all data columns and rows of the subviews that they represent. They will also contain hyperlinks that link them to each other. The hyperlink on the web pages you create will be:

<table>
<thead>
<tr>
<th>Page</th>
<th>Hyperlinks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team batting</td>
<td>Team pitching and day-by-day batting pages (each player)</td>
</tr>
<tr>
<td>Day-by-day batting</td>
<td>Team batting</td>
</tr>
<tr>
<td>Team pitching</td>
<td>Team batting and day-by-day pitching (each pitcher)</td>
</tr>
<tr>
<td>Day-by-day pitching</td>
<td>Team pitching</td>
</tr>
</tbody>
</table>

To create batting and pitching web pages, select File Create team statistics web... The Web page specifications dialog will appear allowing you to change the web page specifications. In addition to specifying the path and file name prefix for web pages, you can change the following specifications for each web page:

Page title
Heading 1 text and font size
Heading 2 text and font size

You can include several variables in the title and heading lines. You can also include any additional HTML tags in the title text. When you finish changing specifications, press the Create pages button to create the web pages.

ScorePAD creates web pages in HTML format with hyperlinks inserted. These pages can be immediately uploaded to your website and used to browse your team's performance.

Once you have setup your web page specifications, the process from HotSync to Web should take less than ten minutes after each game.
Changing Web page specifications

You can change web page settings before you begin creating web pages or during the web page creation process. To change web page settings before your next export, select File Web page settings... The Web page specifications dialog will appear. In this dialog you can select the subviews from which you want to create web pages. You can also specify directory and file name prefix.

For each page, you can change the title and heading text. To change them, press the appropriate button on the Web specification dialog. The Web page settings dialog will appear allowing you to change the heading and title strings.

You can include the following variables in the title, heading 1 and heading 2 text:

&L League name
&T Team name
&S  Statistics start date
&E  Statistics end date
&P  Player name (First initial and last name)
\n  Newline

You can also include HTML tags in the title strings. In fact, you can include up to 10K of HTML in each heading. ScorePAD doesn't check the HTML for errors so you should be careful.

Web page strings

Page title: Player statistics for &T

Heading 1: Player statistics for League: &L Team: &T From &S to &E

Font size: 4

Heading 2:

Font size: 4

Recognized variables:

&L  League    Note: You can also place
&T  Team      raw HTML code in these
&S  Begin date headings. Your HTML will
&E  End date  be placed in the headings
&P  Player    as they are generated with
\n  Newline    no error checking.

[OK]  [Cancel]
ScorePAD Statistics
**Stats subview descriptions**

**Team batting**

<table>
<thead>
<tr>
<th>Description</th>
<th>Abbreviation</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assists</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>At-bats</td>
<td>AB</td>
<td></td>
</tr>
<tr>
<td>Base on balls (walks)</td>
<td>BB</td>
<td></td>
</tr>
<tr>
<td>Base on balls (intentional)</td>
<td>BB</td>
<td></td>
</tr>
<tr>
<td>Bunt Single</td>
<td>BH</td>
<td></td>
</tr>
<tr>
<td>Base path violation</td>
<td>BPV</td>
<td></td>
</tr>
<tr>
<td>Batting average</td>
<td>AVG</td>
<td></td>
</tr>
<tr>
<td>Batting Avg. with 1 out</td>
<td>1O utAvg</td>
<td></td>
</tr>
<tr>
<td>Batting Avg. with 2 outs</td>
<td>2O utAvg</td>
<td></td>
</tr>
<tr>
<td>Batting Avg. with no outs</td>
<td>NO O utAvg</td>
<td></td>
</tr>
<tr>
<td>Bunt foul 3rd strike</td>
<td>Kbf</td>
<td></td>
</tr>
<tr>
<td>Catcher interference</td>
<td>CINT</td>
<td></td>
</tr>
<tr>
<td>Catching percentage</td>
<td>CTCH%</td>
<td></td>
</tr>
<tr>
<td>Caught steals (total)</td>
<td>CS</td>
<td></td>
</tr>
<tr>
<td>Caught stealing 2nd</td>
<td>CS2</td>
<td></td>
</tr>
<tr>
<td>Caught stealing 3rd</td>
<td>CS3</td>
<td></td>
</tr>
<tr>
<td>Caught stealing home</td>
<td>CSH</td>
<td></td>
</tr>
<tr>
<td>Defensive interference</td>
<td>DI</td>
<td></td>
</tr>
<tr>
<td>Double plays</td>
<td>DP</td>
<td></td>
</tr>
<tr>
<td>Doubles</td>
<td>2B</td>
<td></td>
</tr>
<tr>
<td>Dropped 3rd strike - out</td>
<td>Kd3</td>
<td></td>
</tr>
<tr>
<td>Dropped 3rd strike - on</td>
<td>Kd3O</td>
<td></td>
</tr>
<tr>
<td>Errors - Total</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Errors - fielding</td>
<td>Ef</td>
<td></td>
</tr>
<tr>
<td>Errors - throwing</td>
<td>Et</td>
<td></td>
</tr>
<tr>
<td>Fielder's choice</td>
<td>FC</td>
<td></td>
</tr>
<tr>
<td>Fielding percentage</td>
<td>FLD%</td>
<td></td>
</tr>
<tr>
<td>Flyouts</td>
<td>FLYO</td>
<td></td>
</tr>
<tr>
<td>Foulouts</td>
<td>FOULO</td>
<td></td>
</tr>
<tr>
<td>Games played</td>
<td>G</td>
<td></td>
</tr>
<tr>
<td>Games started</td>
<td>GS</td>
<td></td>
</tr>
<tr>
<td>Groundouts</td>
<td>GO</td>
<td></td>
</tr>
<tr>
<td>Ground into double plays</td>
<td>GDP</td>
<td></td>
</tr>
<tr>
<td>Hit-by-pitch</td>
<td>HB</td>
<td></td>
</tr>
<tr>
<td>Hits</td>
<td>H</td>
<td></td>
</tr>
<tr>
<td>Hits with 1 out</td>
<td>1O utH</td>
<td></td>
</tr>
<tr>
<td>Hits with 2 outs</td>
<td>2O utH</td>
<td></td>
</tr>
<tr>
<td>Hits with no outs</td>
<td>NO O utH</td>
<td></td>
</tr>
<tr>
<td>Home runs</td>
<td>HR</td>
<td></td>
</tr>
<tr>
<td>Home run</td>
<td>2RunHR</td>
<td></td>
</tr>
<tr>
<td>Home run</td>
<td>3RunHR</td>
<td></td>
</tr>
<tr>
<td>Homers - Grand slam</td>
<td>Slams</td>
<td></td>
</tr>
<tr>
<td>Homers - Solo</td>
<td>SoloHR</td>
<td></td>
</tr>
<tr>
<td>Illegal batted ball</td>
<td>ILLBAT</td>
<td></td>
</tr>
<tr>
<td>Infield flies</td>
<td>IF</td>
<td></td>
</tr>
<tr>
<td>Infield Singles</td>
<td>IFH</td>
<td></td>
</tr>
<tr>
<td>Innings played</td>
<td>Inn</td>
<td></td>
</tr>
<tr>
<td>Lineouts</td>
<td>LO</td>
<td></td>
</tr>
<tr>
<td>No switch hit</td>
<td>NSW</td>
<td></td>
</tr>
<tr>
<td>Bstructions</td>
<td>OBSTR</td>
<td></td>
</tr>
<tr>
<td>Offensive interference</td>
<td>OFINT</td>
<td></td>
</tr>
<tr>
<td>On-base percentage</td>
<td>OB%</td>
<td></td>
</tr>
<tr>
<td>On-base% + Slugging %</td>
<td>OPS</td>
<td></td>
</tr>
<tr>
<td>Passed balls</td>
<td>PB</td>
<td></td>
</tr>
<tr>
<td>Passed ball percentage</td>
<td>PB%</td>
<td></td>
</tr>
<tr>
<td>Pickoffs</td>
<td>PKO</td>
<td></td>
</tr>
<tr>
<td>Picked off 1st</td>
<td>PKO F1</td>
<td></td>
</tr>
<tr>
<td>Picked off 2nd</td>
<td>PKO F2</td>
<td></td>
</tr>
<tr>
<td>Picked off 3rd</td>
<td>PKO F3</td>
<td></td>
</tr>
<tr>
<td>Pinch at-bats</td>
<td>PAB</td>
<td></td>
</tr>
<tr>
<td>Pinch hits</td>
<td>PH</td>
<td></td>
</tr>
<tr>
<td>Pinch home runs</td>
<td>PH R</td>
<td></td>
</tr>
<tr>
<td>Pinch RBI</td>
<td>PBI</td>
<td></td>
</tr>
<tr>
<td>Pitches received</td>
<td>PCHR</td>
<td></td>
</tr>
<tr>
<td>Plate appearances</td>
<td>PA</td>
<td></td>
</tr>
<tr>
<td>Plate appearances- left</td>
<td>LPA</td>
<td></td>
</tr>
<tr>
<td>Plate appearances- right</td>
<td>RPA</td>
<td></td>
</tr>
<tr>
<td>Player name</td>
<td>Player</td>
<td></td>
</tr>
<tr>
<td>Player number</td>
<td>#</td>
<td></td>
</tr>
<tr>
<td>Put outs</td>
<td>PO</td>
<td></td>
</tr>
<tr>
<td>Reach on error</td>
<td>ERRCH</td>
<td></td>
</tr>
<tr>
<td>Reverse batting hand</td>
<td>RBH</td>
<td></td>
</tr>
<tr>
<td>Runs</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Runs batted in</td>
<td>RBI</td>
<td></td>
</tr>
<tr>
<td>RBI with 2 outs</td>
<td>2O utRBI</td>
<td></td>
</tr>
<tr>
<td>Runners advanced</td>
<td>RA</td>
<td></td>
</tr>
<tr>
<td>Runners in scoring position</td>
<td>RISP</td>
<td></td>
</tr>
<tr>
<td>Runners SP - at-bats</td>
<td>RISPA B</td>
<td></td>
</tr>
<tr>
<td>Runners SP - hits</td>
<td>RISPH</td>
<td></td>
</tr>
<tr>
<td>Runners in SP - Avg.</td>
<td>RISP%</td>
<td></td>
</tr>
<tr>
<td>Runs created</td>
<td>RC</td>
<td></td>
</tr>
<tr>
<td>Sacrifice hits</td>
<td>SH</td>
<td></td>
</tr>
<tr>
<td>Sacrifice flies</td>
<td>SF</td>
<td></td>
</tr>
<tr>
<td>Slugging percentage</td>
<td>SLG%</td>
<td></td>
</tr>
<tr>
<td>Spectator Interference</td>
<td>SPECINT</td>
<td></td>
</tr>
<tr>
<td>Stolen bases (total)</td>
<td>Stolen bases (total)</td>
<td></td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>STL2</td>
<td>Stole 2nd base</td>
<td></td>
</tr>
<tr>
<td>STL3</td>
<td>Stole 3rd base</td>
<td></td>
</tr>
<tr>
<td>STLH</td>
<td>Stole home</td>
<td></td>
</tr>
<tr>
<td>SB%</td>
<td>Stolen base percentage</td>
<td></td>
</tr>
<tr>
<td>STLO N</td>
<td>Stolen on</td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>Strikeouts</td>
<td></td>
</tr>
<tr>
<td>Kc</td>
<td>Strikeouts - called</td>
<td></td>
</tr>
<tr>
<td>Team</td>
<td>Team name</td>
<td></td>
</tr>
<tr>
<td>THW%</td>
<td>Throwing percentage</td>
<td></td>
</tr>
<tr>
<td>THO</td>
<td>Thrown out</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>Total chances</td>
<td></td>
</tr>
<tr>
<td>3B</td>
<td>Triples</td>
<td></td>
</tr>
<tr>
<td>TP</td>
<td>Triple plays</td>
<td></td>
</tr>
<tr>
<td>STL2 Stole 2nd base</td>
<td>+SB% Cumulative stolen base %</td>
<td></td>
</tr>
<tr>
<td>STL3 Stole 3rd base</td>
<td>D/N Day or night game</td>
<td></td>
</tr>
<tr>
<td>STLH Stole home</td>
<td>DEF INT Defensive interference</td>
<td></td>
</tr>
<tr>
<td>SB% Stolen base percentage</td>
<td>POS Defensive position</td>
<td></td>
</tr>
<tr>
<td>STLO N Stolen on</td>
<td>2B Doubles</td>
<td></td>
</tr>
<tr>
<td>K Strikeouts</td>
<td>Kd3 Dropped 3rd strike - out</td>
<td></td>
</tr>
<tr>
<td>Kc Strikeouts - called</td>
<td>Kd3O Dropped 3rd strike - on</td>
<td></td>
</tr>
<tr>
<td>Team Team name</td>
<td>DP Double plays</td>
<td></td>
</tr>
<tr>
<td>THW% Throwing percentage</td>
<td>E Errors (total)</td>
<td></td>
</tr>
<tr>
<td>THO Thrown out</td>
<td>Ef Errors - fielding</td>
<td></td>
</tr>
<tr>
<td>TB Total bases</td>
<td>Et Errors - throwing</td>
<td></td>
</tr>
<tr>
<td>TC Total chances</td>
<td>FC Fielder's choice</td>
<td></td>
</tr>
<tr>
<td>3B Triples</td>
<td>FLD% Fielding percentage</td>
<td></td>
</tr>
<tr>
<td>TP Triple plays</td>
<td>Score Final score</td>
<td></td>
</tr>
<tr>
<td>+AVG Cumulative Batting average</td>
<td>FLYO Flyouts</td>
<td></td>
</tr>
<tr>
<td>+FLD% Cumulative fielding %</td>
<td>FO ULO Foulouts</td>
<td></td>
</tr>
<tr>
<td>+OB% Cumulative on base %</td>
<td>Game date</td>
<td></td>
</tr>
<tr>
<td>+PB% Cumulative passed ball %</td>
<td>Gm Game number</td>
<td></td>
</tr>
<tr>
<td>+PA Cumulative plate appearances</td>
<td>G Games played</td>
<td></td>
</tr>
<tr>
<td>+LPA Cumulative plate appearances</td>
<td>GS Games started</td>
<td></td>
</tr>
<tr>
<td>+RPA Cumulative plate appearances</td>
<td>GO Groundouts</td>
<td></td>
</tr>
<tr>
<td>+RISP Cumulative runners in SP</td>
<td>GDP Ground into double plays</td>
<td></td>
</tr>
<tr>
<td>+RISP% Cumulative RISP Avg.</td>
<td>HB Hit by pitch</td>
<td></td>
</tr>
<tr>
<td>+SLG% Cumulative slugging %</td>
<td>H Hits</td>
<td></td>
</tr>
<tr>
<td>Day by day batting</td>
<td>10 utH Hits with 1 out</td>
<td></td>
</tr>
<tr>
<td>4+RI 4+ Run Innings</td>
<td>20 utH Hits with 2 outs</td>
<td></td>
</tr>
<tr>
<td>5+RI 5+ Run Innings</td>
<td>NO UTH Hits with no outs</td>
<td></td>
</tr>
<tr>
<td>A Assists</td>
<td>H/R Home or road game</td>
<td></td>
</tr>
<tr>
<td>AB At-bats</td>
<td>HR Home runs</td>
<td></td>
</tr>
<tr>
<td>BB Base on balls (walks)</td>
<td>2RunHR Homers - 2 run</td>
<td></td>
</tr>
<tr>
<td>IBB Base on balls (intentional)</td>
<td>3RunHR Homers - 3 run</td>
<td></td>
</tr>
<tr>
<td>BH Bunt Single</td>
<td>Slams Homers - Grand slam</td>
<td></td>
</tr>
<tr>
<td>BPV Basepath violation</td>
<td>SoloHR Homers - Solo</td>
<td></td>
</tr>
<tr>
<td>AVG Batting average</td>
<td>ILLBAT Illegal batted ball</td>
<td></td>
</tr>
<tr>
<td>ORD Batting order</td>
<td>IF Infield flies</td>
<td></td>
</tr>
<tr>
<td>Kbf Bunt foul 3rd strike</td>
<td>IFH Infield Singles</td>
<td></td>
</tr>
<tr>
<td>CINT Catcher interference</td>
<td>Inn Innings played</td>
<td></td>
</tr>
<tr>
<td>CTC H% Catching percentage</td>
<td>LO Lineouts</td>
<td></td>
</tr>
<tr>
<td>CS Caught steals (total)</td>
<td>NSW No switch hit</td>
<td></td>
</tr>
<tr>
<td>CS2 Caught stealing 2nd</td>
<td>OBSTR Obstructions</td>
<td></td>
</tr>
<tr>
<td>CS3 Caught stealing 3rd</td>
<td>OB% O n-base percentage</td>
<td></td>
</tr>
<tr>
<td>CSH Caught stealing home</td>
<td>O FT Offensive interference</td>
<td></td>
</tr>
<tr>
<td>+AVG Cumulative Batting average</td>
<td>OPS O n-base% + Slugging %</td>
<td></td>
</tr>
<tr>
<td>+OB% Cumulative on base %</td>
<td>OPPonent Opposing team</td>
<td></td>
</tr>
<tr>
<td>+PB% Cumulative passed ball %</td>
<td>PB Passed balls</td>
<td></td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
<td>Abbreviation</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>PB%</td>
<td>Passed ball percentage</td>
<td>TC</td>
</tr>
<tr>
<td>PKO</td>
<td>Pickoffs</td>
<td>3B</td>
</tr>
<tr>
<td>PKO F1</td>
<td>Picked off 1st</td>
<td>TP</td>
</tr>
<tr>
<td>PKO F2</td>
<td>Picked off 2nd</td>
<td></td>
</tr>
<tr>
<td>PKO F3</td>
<td>Picked off 3rd</td>
<td></td>
</tr>
<tr>
<td>PAB</td>
<td>Pinch at-bats</td>
<td></td>
</tr>
<tr>
<td>PH</td>
<td>Pinch hits</td>
<td></td>
</tr>
<tr>
<td>PH R</td>
<td>Pinch home runs</td>
<td></td>
</tr>
<tr>
<td>PBI</td>
<td>Pinch RBI</td>
<td></td>
</tr>
<tr>
<td>PCHR</td>
<td>Pitches received</td>
<td></td>
</tr>
<tr>
<td>PA</td>
<td>Plate appearances</td>
<td></td>
</tr>
<tr>
<td>LPA</td>
<td>Plate appearances - left</td>
<td></td>
</tr>
<tr>
<td>RPA</td>
<td>Plate appearances - right</td>
<td></td>
</tr>
<tr>
<td>Player</td>
<td>Player name</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Player number</td>
<td></td>
</tr>
<tr>
<td>Seq</td>
<td>Player sequence</td>
<td></td>
</tr>
<tr>
<td>PO</td>
<td>Put outs</td>
<td></td>
</tr>
<tr>
<td>ERRCH</td>
<td>Reach on error</td>
<td></td>
</tr>
<tr>
<td>W-L</td>
<td>Record</td>
<td></td>
</tr>
<tr>
<td>RBH</td>
<td>Reverse batting hand</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>Runs</td>
<td></td>
</tr>
<tr>
<td>RBI</td>
<td>Runs batted in</td>
<td></td>
</tr>
<tr>
<td>R2O utRBI</td>
<td>RBI with 2 outs</td>
<td></td>
</tr>
<tr>
<td>RA</td>
<td>Runners advanced</td>
<td></td>
</tr>
<tr>
<td>RISP</td>
<td>Runners in scoring position</td>
<td></td>
</tr>
<tr>
<td>RISPA B</td>
<td>Runners SP - at-bats</td>
<td></td>
</tr>
<tr>
<td>RISPH</td>
<td>Runners SP - hits</td>
<td></td>
</tr>
<tr>
<td>RISP%</td>
<td>Runners in SP - Avg.</td>
<td></td>
</tr>
<tr>
<td>RC</td>
<td>Runs created</td>
<td></td>
</tr>
<tr>
<td>SH</td>
<td>Sacrifice hits</td>
<td></td>
</tr>
<tr>
<td>SF</td>
<td>Sacrifice flies</td>
<td></td>
</tr>
<tr>
<td>SLG%</td>
<td>Slugging percentage</td>
<td></td>
</tr>
<tr>
<td>SPEC INT</td>
<td>Spectator Interference</td>
<td></td>
</tr>
<tr>
<td>STL2</td>
<td>Stole 2nd base</td>
<td></td>
</tr>
<tr>
<td>STL3</td>
<td>Stole 3rd base</td>
<td></td>
</tr>
<tr>
<td>ST LH</td>
<td>Stole home</td>
<td></td>
</tr>
<tr>
<td>SB</td>
<td>Stolen bases</td>
<td></td>
</tr>
<tr>
<td>SB%</td>
<td>Stolen base percentage</td>
<td></td>
</tr>
<tr>
<td>STL ON</td>
<td>Stolen on</td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>Strikeouts</td>
<td></td>
</tr>
<tr>
<td>Kc</td>
<td>Strikeouts - called</td>
<td></td>
</tr>
<tr>
<td>Team</td>
<td>Team name</td>
<td></td>
</tr>
<tr>
<td>TH O</td>
<td>Thrown out</td>
<td></td>
</tr>
<tr>
<td>TH W %</td>
<td>Throwing percentage</td>
<td></td>
</tr>
<tr>
<td>TB</td>
<td>Total bases</td>
<td></td>
</tr>
</tbody>
</table>
Stats subview descriptions - continued

### Team pitching

<table>
<thead>
<tr>
<th>Stat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FBAB</td>
<td>1st batter at-bats</td>
</tr>
<tr>
<td>FBAVG</td>
<td>1st batter Avg.</td>
</tr>
<tr>
<td>FBH</td>
<td>1st batter hits</td>
</tr>
<tr>
<td>FBR%</td>
<td>1st batter reach %</td>
</tr>
<tr>
<td>FBR</td>
<td>1st batter reach</td>
</tr>
<tr>
<td>FBF</td>
<td>1st batters faced</td>
</tr>
<tr>
<td>BK</td>
<td>Balks</td>
</tr>
<tr>
<td>BB</td>
<td>Base on balls (walks)</td>
</tr>
<tr>
<td>IBB</td>
<td>Base on balls (Intentional)</td>
</tr>
<tr>
<td>CG</td>
<td>Complete games</td>
</tr>
<tr>
<td>2B</td>
<td>Doubles</td>
</tr>
<tr>
<td>DPI</td>
<td>Double plays induced</td>
</tr>
<tr>
<td>ER</td>
<td>Earned runs</td>
</tr>
<tr>
<td>ERA</td>
<td>Earned run average</td>
</tr>
<tr>
<td>FPS</td>
<td>First pitch strikes</td>
</tr>
<tr>
<td>FPS%</td>
<td>First pitch strike %</td>
</tr>
<tr>
<td>FLYO</td>
<td>Flyouts</td>
</tr>
<tr>
<td>G</td>
<td>Games played</td>
</tr>
<tr>
<td>GS</td>
<td>Games started</td>
</tr>
<tr>
<td>GF</td>
<td>Games finished</td>
</tr>
<tr>
<td>GO</td>
<td>Groundouts</td>
</tr>
<tr>
<td>HB</td>
<td>Hit Batsmen</td>
</tr>
<tr>
<td>H</td>
<td>Hits</td>
</tr>
<tr>
<td>HR</td>
<td>Home runs</td>
</tr>
<tr>
<td>IP</td>
<td>Innings pitched</td>
</tr>
<tr>
<td>OPPAVG</td>
<td>Opponents average</td>
</tr>
<tr>
<td>PKO</td>
<td>Pickoffs</td>
</tr>
<tr>
<td>AP</td>
<td>Pitches ahead in count</td>
</tr>
<tr>
<td>BP</td>
<td>Pitches behind in count</td>
</tr>
<tr>
<td>EP</td>
<td>Pitches from even counts</td>
</tr>
<tr>
<td>B</td>
<td>Pitches - balls</td>
</tr>
<tr>
<td>S</td>
<td>Pitches - strikes</td>
</tr>
<tr>
<td>F</td>
<td>Pitches - fouled off</td>
</tr>
<tr>
<td>POA</td>
<td>Pitches - pickoff attempts</td>
</tr>
<tr>
<td>NP</td>
<td>Pitches - no pitches</td>
</tr>
<tr>
<td>I</td>
<td>Pitches put in-play</td>
</tr>
<tr>
<td>TOTP</td>
<td>Pitches - total</td>
</tr>
<tr>
<td>#</td>
<td>Player number</td>
</tr>
<tr>
<td>Player</td>
<td>Player name</td>
</tr>
<tr>
<td>SEQ</td>
<td>Player sequence</td>
</tr>
<tr>
<td>R</td>
<td>Runs</td>
</tr>
<tr>
<td>SH</td>
<td>Sacrifice hits</td>
</tr>
</tbody>
</table>

### Day by day pitching

<table>
<thead>
<tr>
<th>Stat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF</td>
<td>Sacrifice flies</td>
</tr>
<tr>
<td>SV</td>
<td>Saves</td>
</tr>
<tr>
<td>SVO</td>
<td>Save opportunities</td>
</tr>
<tr>
<td>SHO</td>
<td>Shut outs</td>
</tr>
<tr>
<td>SB</td>
<td>Stolen bases</td>
</tr>
<tr>
<td>SBA</td>
<td>Stolen base attempts</td>
</tr>
<tr>
<td>SB%</td>
<td>Stolen base %</td>
</tr>
<tr>
<td>Team</td>
<td>Team name</td>
</tr>
<tr>
<td>TH</td>
<td>Throwing hand</td>
</tr>
<tr>
<td>TAB</td>
<td>Total at-bats</td>
</tr>
<tr>
<td>3B</td>
<td>Triples</td>
</tr>
<tr>
<td>K</td>
<td>Strikeouts</td>
</tr>
<tr>
<td>Kc</td>
<td>Strikeouts (called)</td>
</tr>
<tr>
<td>K%</td>
<td>Strikeout %</td>
</tr>
<tr>
<td>KW%</td>
<td>Strikeouts to walks %</td>
</tr>
<tr>
<td>WP</td>
<td>W ild pitches</td>
</tr>
<tr>
<td>W IN%</td>
<td>W in %</td>
</tr>
<tr>
<td>W-L</td>
<td>Won-Loss record</td>
</tr>
<tr>
<td>DATE</td>
<td>Date</td>
</tr>
<tr>
<td>D/N</td>
<td>Day or night game</td>
</tr>
<tr>
<td>2B</td>
<td>Doubles</td>
</tr>
<tr>
<td>ER</td>
<td>Earned runs</td>
</tr>
<tr>
<td>FBAVG</td>
<td>1st batter Avg.</td>
</tr>
<tr>
<td>FBH</td>
<td>1st batter hits</td>
</tr>
<tr>
<td>FBAB</td>
<td>1st batter at-bats</td>
</tr>
<tr>
<td>IBB</td>
<td>Base on balls (Intentional)</td>
</tr>
<tr>
<td>CG</td>
<td>Complete games</td>
</tr>
<tr>
<td>OPPAVG</td>
<td>Opponents average</td>
</tr>
<tr>
<td>PKO</td>
<td>Pickoffs</td>
</tr>
<tr>
<td>AP</td>
<td>Pitches ahead in count</td>
</tr>
<tr>
<td>BP</td>
<td>Pitches behind in count</td>
</tr>
<tr>
<td>EP</td>
<td>Pitches from even counts</td>
</tr>
<tr>
<td>B</td>
<td>Pitches - balls</td>
</tr>
<tr>
<td>S</td>
<td>Pitches - strikes</td>
</tr>
<tr>
<td>F</td>
<td>Pitches - fouled off</td>
</tr>
<tr>
<td>POA</td>
<td>Pitches - pickoff attempts</td>
</tr>
<tr>
<td>NP</td>
<td>Pitches - no pitches</td>
</tr>
<tr>
<td>I</td>
<td>Pitches put in-play</td>
</tr>
<tr>
<td>TOTP</td>
<td>Pitches - total</td>
</tr>
<tr>
<td>#</td>
<td>Player number</td>
</tr>
<tr>
<td>Player</td>
<td>Player name</td>
</tr>
<tr>
<td>SEQ</td>
<td>Player sequence</td>
</tr>
<tr>
<td>R</td>
<td>Runs</td>
</tr>
<tr>
<td>SH</td>
<td>Sacrifice hits</td>
</tr>
<tr>
<td>FPS</td>
<td>First pitch strikes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERA</td>
<td>Earned run average</td>
</tr>
<tr>
<td>+ERA</td>
<td>Earned run average (cum)</td>
</tr>
<tr>
<td>W-L</td>
<td>Cumulative Record</td>
</tr>
<tr>
<td>DATE</td>
<td>Date</td>
</tr>
<tr>
<td>D/N</td>
<td>Day or night game</td>
</tr>
<tr>
<td>2B</td>
<td>Doubles</td>
</tr>
<tr>
<td>ER</td>
<td>Earned runs</td>
</tr>
<tr>
<td>OPPAVG</td>
<td>Opponents average</td>
</tr>
<tr>
<td>PKO</td>
<td>Pickoffs</td>
</tr>
<tr>
<td>AP</td>
<td>Pitches ahead in count</td>
</tr>
<tr>
<td>BP</td>
<td>Pitches behind in count</td>
</tr>
<tr>
<td>EP</td>
<td>Pitches from even counts</td>
</tr>
<tr>
<td>B</td>
<td>Pitches - balls</td>
</tr>
<tr>
<td>S</td>
<td>Pitches - strikes</td>
</tr>
<tr>
<td>F</td>
<td>Pitches - fouled off</td>
</tr>
<tr>
<td>POA</td>
<td>Pitches - pickoff attempts</td>
</tr>
<tr>
<td>NP</td>
<td>Pitches - no pitches</td>
</tr>
<tr>
<td>I</td>
<td>Pitches put in-play</td>
</tr>
<tr>
<td>TOTP</td>
<td>Pitches - total</td>
</tr>
<tr>
<td>#</td>
<td>Player number</td>
</tr>
<tr>
<td>Player</td>
<td>Player name</td>
</tr>
<tr>
<td>SEQ</td>
<td>Player sequence</td>
</tr>
<tr>
<td>R</td>
<td>Runs</td>
</tr>
<tr>
<td>SH</td>
<td>Sacrifice hits</td>
</tr>
<tr>
<td>FPS</td>
<td>First pitch strikes</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>FPS%</td>
<td>First pitch strike %</td>
</tr>
<tr>
<td>+FPS%</td>
<td>FPS% (cumulative)</td>
</tr>
<tr>
<td>FLYO</td>
<td>Flyouts</td>
</tr>
<tr>
<td>GF</td>
<td>Games finished</td>
</tr>
<tr>
<td>Gm</td>
<td>Game number</td>
</tr>
<tr>
<td>GS</td>
<td>Games started</td>
</tr>
<tr>
<td>Date</td>
<td>Game date</td>
</tr>
<tr>
<td>GO</td>
<td>Groundouts</td>
</tr>
<tr>
<td>HB</td>
<td>Hit batsmen</td>
</tr>
<tr>
<td>H</td>
<td>Hits</td>
</tr>
<tr>
<td>H/R</td>
<td>Home or road game</td>
</tr>
<tr>
<td>HR</td>
<td>Home runs</td>
</tr>
<tr>
<td>IP</td>
<td>Innings pitched</td>
</tr>
<tr>
<td>OPPAVG</td>
<td>Opponents average</td>
</tr>
<tr>
<td>+OPPAVG</td>
<td>Opp average (cum)</td>
</tr>
<tr>
<td>Opponent</td>
<td>Opposing team</td>
</tr>
<tr>
<td>PKO</td>
<td>Pickoffs</td>
</tr>
<tr>
<td>AP</td>
<td>Pitches ahead in count</td>
</tr>
<tr>
<td>BP</td>
<td>Pitches behind in count</td>
</tr>
<tr>
<td>EP</td>
<td>Pitches from even counts</td>
</tr>
<tr>
<td>B</td>
<td>Pitches - balls</td>
</tr>
<tr>
<td>S</td>
<td>Pitches - strikes</td>
</tr>
<tr>
<td>F</td>
<td>Pitches - fouled off</td>
</tr>
<tr>
<td>POA</td>
<td>Pitches - pickoff attempts</td>
</tr>
<tr>
<td>NP</td>
<td>Pitches - no pitches</td>
</tr>
<tr>
<td>I</td>
<td>Pitches put in-play</td>
</tr>
<tr>
<td>TOTP</td>
<td>Pitches - total</td>
</tr>
<tr>
<td>#</td>
<td>Player number</td>
</tr>
<tr>
<td>Player</td>
<td>Player name</td>
</tr>
<tr>
<td>W-L</td>
<td>Record</td>
</tr>
<tr>
<td>+W-L</td>
<td>Record - cumulative</td>
</tr>
<tr>
<td>R</td>
<td>Runs</td>
</tr>
<tr>
<td>SH</td>
<td>Sacrifice hits</td>
</tr>
<tr>
<td>SF</td>
<td>Sacrifice flies</td>
</tr>
<tr>
<td>SV</td>
<td>Saves</td>
</tr>
<tr>
<td>SVO</td>
<td>Save opportunities</td>
</tr>
<tr>
<td>SH</td>
<td>Shut outs</td>
</tr>
<tr>
<td>SB</td>
<td>Stolen bases</td>
</tr>
<tr>
<td>SBA</td>
<td>Stolen base attempts</td>
</tr>
<tr>
<td>SB%</td>
<td>Stolen base %</td>
</tr>
<tr>
<td>+SB%</td>
<td>Stolen base % (cum)</td>
</tr>
<tr>
<td>K</td>
<td>Strikeouts</td>
</tr>
<tr>
<td>Kc</td>
<td>Strikeouts (called)</td>
</tr>
<tr>
<td>KW%</td>
<td>Strikeouts to walks %</td>
</tr>
<tr>
<td>K%</td>
<td>Strikeout %</td>
</tr>
<tr>
<td>Team</td>
<td>Team name</td>
</tr>
<tr>
<td>TH</td>
<td>Throwing hand</td>
</tr>
<tr>
<td>TBF</td>
<td>Total batters faced</td>
</tr>
<tr>
<td>TAB</td>
<td>Total at-bats</td>
</tr>
<tr>
<td>3B</td>
<td>Triples</td>
</tr>
<tr>
<td>WP</td>
<td>Wild pitches</td>
</tr>
</tbody>
</table>

**Defense**

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Assists</td>
</tr>
<tr>
<td>CTCH%</td>
<td>Catching percentage</td>
</tr>
<tr>
<td>Pos</td>
<td>Defensive position</td>
</tr>
<tr>
<td>DP</td>
<td>Double plays</td>
</tr>
<tr>
<td>E</td>
<td>Errors - total</td>
</tr>
<tr>
<td>Ef</td>
<td>Errors - fielding</td>
</tr>
<tr>
<td>Et</td>
<td>Errors - throwing</td>
</tr>
<tr>
<td>FLD%</td>
<td>Fielding percentage</td>
</tr>
<tr>
<td>G</td>
<td>Game played</td>
</tr>
<tr>
<td>GS</td>
<td>Games started</td>
</tr>
<tr>
<td>Inn</td>
<td>Innings played</td>
</tr>
<tr>
<td>PB</td>
<td>Passed balls</td>
</tr>
<tr>
<td>PB%</td>
<td>Passed ball percentage</td>
</tr>
<tr>
<td>PCHR</td>
<td>Pitches received</td>
</tr>
<tr>
<td>Player</td>
<td>Player name</td>
</tr>
<tr>
<td>#</td>
<td>Player number</td>
</tr>
<tr>
<td>PO</td>
<td>Putouts</td>
</tr>
<tr>
<td>STLO N</td>
<td>Stolen bases allowed</td>
</tr>
<tr>
<td>SB%</td>
<td>Stolen base percentage</td>
</tr>
<tr>
<td>THW%</td>
<td>Throwing percentage</td>
</tr>
<tr>
<td>THO</td>
<td>Thrown out</td>
</tr>
<tr>
<td>TC</td>
<td>Total chances</td>
</tr>
</tbody>
</table>
Stats subview descriptions - continued

Home runs
Gm  Game number
Date  Game date
Opponent  Opposing team
H/R  Home or road game
D/N  Day or night game
Player  Batter that hit home run
HR  Home run number
Pitcher  Pitcher home run hit against
Count  Ball and strike count when hit
Inn  Inning of home run
Runs  Number of runs scored

Games
Gm  Game number
Date  Game date
Opponent  Opposing team
H/R  Home or road game
D/N  Day or night game
Score  Final score of game
W/L  Win or Loss
Record  Running record of team
Stndg  Standing of team after game
Gms 1st  Games from first place
Winning pitcher  Pitcher award the win
Losing pitcher  Pitcher charged with lose
Save pitcher  Pitcher credit with save
Attendance  Number of fans attending game
Total Attend  Total home attendance for loaded team
Duration  Duration of game in hours and minutes
File Formats

All import formats require fields in the order below. You don't have to include all fields as long as the ones you do include are right order and contain information in the right format.

Each line ends with a carriage return followed by a line feed
Each field must be separated by a comma
Each character field must be inclosed in double quotes ("")

RosterPAD Import/Export file format

<table>
<thead>
<tr>
<th>#</th>
<th>Name</th>
<th>Format</th>
<th>Restrictions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Last name</td>
<td>char</td>
<td>up to 15 chars</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>First name</td>
<td>char</td>
<td>up to 15 chars</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>League</td>
<td>char</td>
<td>up to 16 chars</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Team</td>
<td>char</td>
<td>up to 8 chars</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Number</td>
<td>numeric</td>
<td>0-99</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Physical</td>
<td>char</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Bats</td>
<td>char</td>
<td>R, L, or S</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Throws</td>
<td>char</td>
<td>R or L</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Batting order</td>
<td>numeric</td>
<td>0-16</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Position</td>
<td>numeric</td>
<td>0-14</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Address</td>
<td>char</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>City, State</td>
<td>char</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Zip</td>
<td>char</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Phone</td>
<td>char</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Notes</td>
<td>char</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>G</td>
<td>numeric</td>
<td></td>
<td>Games played</td>
</tr>
<tr>
<td>17</td>
<td>GS</td>
<td>numeric</td>
<td></td>
<td>Games started</td>
</tr>
<tr>
<td>18</td>
<td>PA</td>
<td>numeric</td>
<td></td>
<td>Plate appearances</td>
</tr>
<tr>
<td>19</td>
<td>At-bats</td>
<td>numeric</td>
<td></td>
<td>At-bats</td>
</tr>
<tr>
<td>20</td>
<td>R</td>
<td>numeric</td>
<td></td>
<td>Runs</td>
</tr>
<tr>
<td>21</td>
<td>H</td>
<td>numeric</td>
<td></td>
<td>Hits</td>
</tr>
<tr>
<td>22</td>
<td>2B</td>
<td>numeric</td>
<td></td>
<td>Doubles</td>
</tr>
<tr>
<td>23</td>
<td>3B</td>
<td>numeric</td>
<td></td>
<td>Triples</td>
</tr>
<tr>
<td>24</td>
<td>HR</td>
<td>numeric</td>
<td></td>
<td>Home runs</td>
</tr>
<tr>
<td>25</td>
<td>RBI</td>
<td>numeric</td>
<td></td>
<td>Runs batted in</td>
</tr>
<tr>
<td>26</td>
<td>K</td>
<td>numeric</td>
<td></td>
<td>Strikeouts</td>
</tr>
<tr>
<td>27</td>
<td>Kc</td>
<td>numeric</td>
<td></td>
<td>Called strikeouts</td>
</tr>
<tr>
<td>28</td>
<td>SB</td>
<td>numeric</td>
<td></td>
<td>Stolen bases</td>
</tr>
<tr>
<td>29</td>
<td>SH</td>
<td>numeric</td>
<td></td>
<td>Sac hits</td>
</tr>
<tr>
<td>30</td>
<td>SF</td>
<td>numeric</td>
<td></td>
<td>Sac flies</td>
</tr>
</tbody>
</table>
### RosterPAD fields continued

<table>
<thead>
<tr>
<th>Field</th>
<th>Format</th>
<th>Restrictions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31. HBP</td>
<td>numeric</td>
<td></td>
<td>Hit by pitch</td>
</tr>
<tr>
<td>32. BB</td>
<td>numeric</td>
<td></td>
<td>Base on balls</td>
</tr>
<tr>
<td>33. IBB</td>
<td>numeric</td>
<td></td>
<td>Intentional base on balls</td>
</tr>
<tr>
<td>34. CS</td>
<td>numeric</td>
<td></td>
<td>Caught steals</td>
</tr>
<tr>
<td>35. GDP</td>
<td>numeric</td>
<td></td>
<td>Ground into double play</td>
</tr>
<tr>
<td>36. A</td>
<td>numeric</td>
<td></td>
<td>Assists</td>
</tr>
<tr>
<td>37. PO</td>
<td>numeric</td>
<td></td>
<td>Putouts</td>
</tr>
<tr>
<td>38. DP</td>
<td>numeric</td>
<td></td>
<td>Double plays</td>
</tr>
<tr>
<td>39. E</td>
<td>numeric</td>
<td></td>
<td>Errors</td>
</tr>
<tr>
<td>40. PB</td>
<td>numeric</td>
<td></td>
<td>Passed balls</td>
</tr>
<tr>
<td>41. PAB</td>
<td>numeric</td>
<td></td>
<td>Pinch at-bats</td>
</tr>
<tr>
<td>42. PH</td>
<td>numeric</td>
<td></td>
<td>Pinch hits</td>
</tr>
<tr>
<td>43. PRBI</td>
<td>numeric</td>
<td></td>
<td>Pinch RBI</td>
</tr>
<tr>
<td>44. PHR</td>
<td>numeric</td>
<td></td>
<td>Pinch home runs</td>
</tr>
</tbody>
</table>

**Pitcher stats**

<table>
<thead>
<tr>
<th>Field</th>
<th>Format</th>
<th>Restrictions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>45. G</td>
<td>numeric</td>
<td></td>
<td>Games as pitcher</td>
</tr>
<tr>
<td>46. GS</td>
<td>numeric</td>
<td></td>
<td>Games started as pitcher</td>
</tr>
<tr>
<td>47. CG</td>
<td>numeric</td>
<td></td>
<td>Complete games</td>
</tr>
<tr>
<td>48. SHO</td>
<td>numeric</td>
<td></td>
<td>Shutouts</td>
</tr>
<tr>
<td>49. W</td>
<td>numeric</td>
<td></td>
<td>Wins</td>
</tr>
<tr>
<td>50. L</td>
<td>numeric</td>
<td></td>
<td>Loses</td>
</tr>
<tr>
<td>51. S</td>
<td>numeric</td>
<td></td>
<td>Saves</td>
</tr>
<tr>
<td>52. SVO</td>
<td>numeric</td>
<td></td>
<td>Save opportunities</td>
</tr>
<tr>
<td>53. FG</td>
<td>numeric</td>
<td></td>
<td>Finished games</td>
</tr>
<tr>
<td>54. ND</td>
<td>numeric</td>
<td></td>
<td>No decisions</td>
</tr>
<tr>
<td>55. IP</td>
<td>numeric</td>
<td>1.1 = 1-1/3 Inn</td>
<td>Innings pitched</td>
</tr>
<tr>
<td>56. BF</td>
<td>numeric</td>
<td></td>
<td>Batters faced</td>
</tr>
<tr>
<td>57. A B</td>
<td>numeric</td>
<td></td>
<td>At-bats</td>
</tr>
<tr>
<td>58. H</td>
<td>numeric</td>
<td></td>
<td>Hits given up</td>
</tr>
<tr>
<td>59. HR</td>
<td>numeric</td>
<td></td>
<td>Homers given up</td>
</tr>
<tr>
<td>60. ER</td>
<td>numeric</td>
<td></td>
<td>Earned runs</td>
</tr>
<tr>
<td>61. R</td>
<td>numeric</td>
<td></td>
<td>Total runs</td>
</tr>
<tr>
<td>62. BB</td>
<td>numeric</td>
<td></td>
<td>Walks</td>
</tr>
<tr>
<td>63. IBB</td>
<td>numeric</td>
<td></td>
<td>Intentional walks</td>
</tr>
<tr>
<td>64. K</td>
<td>numeric</td>
<td></td>
<td>Total strikeouts</td>
</tr>
<tr>
<td>65. Kc</td>
<td>numeric</td>
<td></td>
<td>Called strikeouts</td>
</tr>
<tr>
<td>66. WP</td>
<td>numeric</td>
<td></td>
<td>Wild pitches</td>
</tr>
<tr>
<td>67. BK</td>
<td>numeric</td>
<td></td>
<td>Balks</td>
</tr>
<tr>
<td>68. HB</td>
<td>numeric</td>
<td></td>
<td>Hit batters</td>
</tr>
<tr>
<td>69. SBA</td>
<td>numeric</td>
<td></td>
<td>Stolen base attempts</td>
</tr>
<tr>
<td>70. SB</td>
<td>numeric</td>
<td></td>
<td>Stolen bases</td>
</tr>
</tbody>
</table>
Game statistics export file format

The export file for games contains position player and pitcher statistics for each player and each team - position player statistics first, then pitcher statistics.

A line of field titles will precede each team's players. After the position player statistics, will appear the word Pitchers on a single line followed by a line of pitcher statistics titles.

Exported position player statistics

<table>
<thead>
<tr>
<th>#</th>
<th>Name</th>
<th>Format</th>
<th>Restrictions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Team</td>
<td>char</td>
<td>up to 8 chars</td>
<td>Team name</td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>char</td>
<td></td>
<td>Player name</td>
</tr>
<tr>
<td>3</td>
<td>Order</td>
<td>numeric</td>
<td></td>
<td>Batting order</td>
</tr>
<tr>
<td>4</td>
<td>Pos</td>
<td>char</td>
<td></td>
<td>Position</td>
</tr>
<tr>
<td>5</td>
<td>Inn</td>
<td>numeric</td>
<td>1.1 = 1-1/3 Inn</td>
<td>Innings at position</td>
</tr>
<tr>
<td>6</td>
<td>PA</td>
<td>numeric</td>
<td></td>
<td>Plate appearances</td>
</tr>
<tr>
<td>7</td>
<td>AB</td>
<td>numeric</td>
<td></td>
<td>At-bats</td>
</tr>
<tr>
<td>8</td>
<td>R</td>
<td>numeric</td>
<td></td>
<td>Runs</td>
</tr>
<tr>
<td>9</td>
<td>H</td>
<td>numeric</td>
<td></td>
<td>Hits</td>
</tr>
<tr>
<td>10</td>
<td>TB</td>
<td>numeric</td>
<td></td>
<td>Total bases</td>
</tr>
<tr>
<td>11</td>
<td>2B</td>
<td>numeric</td>
<td></td>
<td>Doubles</td>
</tr>
<tr>
<td>12</td>
<td>3B</td>
<td>numeric</td>
<td></td>
<td>Triples</td>
</tr>
<tr>
<td>13</td>
<td>HR</td>
<td>numeric</td>
<td></td>
<td>Home runs</td>
</tr>
<tr>
<td>14</td>
<td>FC</td>
<td>numeric</td>
<td></td>
<td>Fielder's choice</td>
</tr>
<tr>
<td>15</td>
<td>ERRCH</td>
<td>numeric</td>
<td></td>
<td>Reached on error</td>
</tr>
<tr>
<td>16</td>
<td>DEFINT</td>
<td>numeric</td>
<td></td>
<td>Defensive interference</td>
</tr>
<tr>
<td>17</td>
<td>OBSTR</td>
<td>numeric</td>
<td></td>
<td>Obstruction</td>
</tr>
<tr>
<td>18</td>
<td>RBI</td>
<td>numeric</td>
<td></td>
<td>Runs batted in</td>
</tr>
<tr>
<td>19</td>
<td>SH</td>
<td>numeric</td>
<td></td>
<td>Sac hits</td>
</tr>
<tr>
<td>20</td>
<td>SF</td>
<td>numeric</td>
<td></td>
<td>Sac flies</td>
</tr>
<tr>
<td>21</td>
<td>HBP</td>
<td>numeric</td>
<td></td>
<td>Hit by pitch</td>
</tr>
<tr>
<td>22</td>
<td>BB</td>
<td>numeric</td>
<td></td>
<td>Base on balls</td>
</tr>
<tr>
<td>23</td>
<td>IBB</td>
<td>numeric</td>
<td></td>
<td>Intentional base on balls</td>
</tr>
<tr>
<td>24</td>
<td>STL2</td>
<td>numeric</td>
<td></td>
<td>Stole 2nd</td>
</tr>
<tr>
<td>25</td>
<td>STL3</td>
<td>numeric</td>
<td></td>
<td>Stole 3rd</td>
</tr>
<tr>
<td>26</td>
<td>STLH</td>
<td>numeric</td>
<td></td>
<td>Stole home</td>
</tr>
<tr>
<td>27</td>
<td>C S2</td>
<td>numeric</td>
<td></td>
<td>Caught stealing 2nd</td>
</tr>
<tr>
<td>28</td>
<td>C S3</td>
<td>numeric</td>
<td></td>
<td>Caught stealing 3rd</td>
</tr>
<tr>
<td>29</td>
<td>C SH</td>
<td>numeric</td>
<td></td>
<td>Caught stealing home</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30. PKOF1 numeric</td>
<td>Picked off at 1st</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31. PKOF2 numeric</td>
<td>Picked off at 2nd</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32. PKOF3 numeric</td>
<td>Picked off at 3rd</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33. K numeric</td>
<td>Total strikeouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34. Kc numeric</td>
<td>Called strikeouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35. SB numeric</td>
<td>Stolen bases</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36. CS numeric</td>
<td>Caught stealing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37. GDP numeric</td>
<td>Ground into double play</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38. ET numeric</td>
<td>Throwing errors</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39. EF numeric</td>
<td>Fielding errors</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40. GO numeric</td>
<td>Groundouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41. LO numeric</td>
<td>Lineouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42. FLYO numeric</td>
<td>Flyouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43. POPO numeric</td>
<td>Popouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44. FOULO numeric</td>
<td>Foulouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45. TP numeric</td>
<td>Triple plays</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46. IF numeric</td>
<td>Infield flies</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47. KBF numeric</td>
<td>Bunt foul 3rd strike</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48. OFINT numeric</td>
<td>Offensive interference</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49. ILLBAT numeric</td>
<td>Illegal batted ball</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50. BPV numeric</td>
<td>Basepath violation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51. SPECINT numeric</td>
<td>Spectator interference</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52. PAB numeric</td>
<td>Pinch at-bats</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53. PH numeric</td>
<td>Pinch hits</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54. PHR numeric</td>
<td>Pinch home runs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55. PRBI numeric</td>
<td>Pinch RBI</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>56. PO numeric</td>
<td>Putouts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57. A numeric</td>
<td>Assists</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58. DP numeric</td>
<td>Double plays</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59. PB numeric</td>
<td>Passed balls</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60. PCHR numeric</td>
<td>Pitches received</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61. STLO N numeric</td>
<td>Stolen on</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62. THO numeric</td>
<td>Thrown out</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63. CINT numeric</td>
<td>Catcher interference</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64. Kd3 numeric</td>
<td>Dropped 3rd strike - on-base</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65. Kd30 numeric</td>
<td>Dropped 3rd strike - out</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Exported pitcher statistics

<table>
<thead>
<tr>
<th>#</th>
<th>Name</th>
<th>Format</th>
<th>Restrictions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Team</td>
<td>char</td>
<td>up to 8 chars</td>
<td>Team name</td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>char</td>
<td></td>
<td>Player name</td>
</tr>
<tr>
<td>3</td>
<td>IP</td>
<td>numeric</td>
<td>1.1 = 1-1/3 Inn</td>
<td>Innings pitched</td>
</tr>
<tr>
<td>4</td>
<td>H</td>
<td>numeric</td>
<td></td>
<td>Hits</td>
</tr>
<tr>
<td>5</td>
<td>AB</td>
<td>numeric</td>
<td></td>
<td>At-bats</td>
</tr>
<tr>
<td>6</td>
<td>BF</td>
<td>numeric</td>
<td></td>
<td>Batters faced</td>
</tr>
<tr>
<td>7</td>
<td>R</td>
<td>numeric</td>
<td></td>
<td>Runs</td>
</tr>
<tr>
<td>8</td>
<td>ER</td>
<td>numeric</td>
<td></td>
<td>Earned runs</td>
</tr>
<tr>
<td>9</td>
<td>1B</td>
<td>numeric</td>
<td></td>
<td>Total bases</td>
</tr>
<tr>
<td>10</td>
<td>2B</td>
<td>numeric</td>
<td></td>
<td>Doubles</td>
</tr>
<tr>
<td>11</td>
<td>3B</td>
<td>numeric</td>
<td></td>
<td>Triples</td>
</tr>
<tr>
<td>12</td>
<td>HR</td>
<td>numeric</td>
<td></td>
<td>Home runs</td>
</tr>
<tr>
<td>13</td>
<td>SH</td>
<td>numeric</td>
<td></td>
<td>Sac hits</td>
</tr>
<tr>
<td>14</td>
<td>SF</td>
<td>numeric</td>
<td></td>
<td>Sac flies</td>
</tr>
<tr>
<td>15</td>
<td>HB</td>
<td>numeric</td>
<td></td>
<td>Hit batters</td>
</tr>
<tr>
<td>16</td>
<td>BB</td>
<td>numeric</td>
<td></td>
<td>Base on balls</td>
</tr>
<tr>
<td>17</td>
<td>IBB</td>
<td>numeric</td>
<td></td>
<td>Intentional base on balls</td>
</tr>
<tr>
<td>18</td>
<td>K</td>
<td>numeric</td>
<td></td>
<td>Strikeouts</td>
</tr>
<tr>
<td>19</td>
<td>Kc</td>
<td>numeric</td>
<td></td>
<td>Called strikeouts</td>
</tr>
<tr>
<td>20</td>
<td>WP</td>
<td>numeric</td>
<td></td>
<td>Wild pitches</td>
</tr>
<tr>
<td>21</td>
<td>BK</td>
<td>numeric</td>
<td></td>
<td>Balks</td>
</tr>
<tr>
<td>22</td>
<td>B</td>
<td>numeric</td>
<td></td>
<td>Balls</td>
</tr>
<tr>
<td>23</td>
<td>S</td>
<td>numeric</td>
<td></td>
<td>Strikes</td>
</tr>
<tr>
<td>24</td>
<td>Sc</td>
<td>numeric</td>
<td></td>
<td>Called strikes</td>
</tr>
<tr>
<td>25</td>
<td>F</td>
<td>numeric</td>
<td></td>
<td>Foul</td>
</tr>
<tr>
<td>26</td>
<td>POA</td>
<td>numeric</td>
<td></td>
<td>Pick off attempts</td>
</tr>
<tr>
<td>27</td>
<td>NP</td>
<td>numeric</td>
<td></td>
<td>No pitches</td>
</tr>
<tr>
<td>28</td>
<td>I</td>
<td>numeric</td>
<td></td>
<td>Balls put in play</td>
</tr>
<tr>
<td>29</td>
<td>FPS</td>
<td>numeric</td>
<td></td>
<td>First pitch strikes</td>
</tr>
<tr>
<td>30</td>
<td>BP</td>
<td>numeric</td>
<td></td>
<td>Pitches behind in count</td>
</tr>
<tr>
<td>31</td>
<td>EP</td>
<td>numeric</td>
<td></td>
<td>Pitches from even counts</td>
</tr>
<tr>
<td>32</td>
<td>AP</td>
<td>numeric</td>
<td></td>
<td>Pitches ahead in count</td>
</tr>
</tbody>
</table>
Frequently Asked Questions
Frequently Asked Questions

“How do I setup a 7-inning game instead of the normal 9-innings?”

You can set the number of scheduled innings for each game between 3 and 16. When the players have completed that number of innings without a tie, ScorePAD will automatically mark the game as complete. ScorePAD will prompt you to set the game’s End Time after the last out of the last scheduled inning or after the winning run scores in bottom of the last scheduled or any extra inning.

If you neglected to set the Scheduled Innings value to the correct number of innings and ScorePAD prematurely ends a game, you can change the Schedule Innings value, set the End Time of the game to “In Progress” and resume scoring.

“How do I setup the International Tie-Breaker Rule?”

If you are using the International Tie-Breaker Rule (ITR), and the game is tied at the end of the last scheduled inning, ScorePAD will automatically implement the ITR placing a runner on second at the beginning of each half inning.

In the batter view, click the menu button. Under Options, check the “Int’l tie-breaker” box. Once this box is selected, ScorePAD will implement this rule every half inning until an inning completes without a tie score. You can turn this preference on or off at any time.

“In our league, the batters begin each at bat with 1 ball and 1 strike. Can I setup ScorePAD to automatically register that count?”

In some softball tournaments, each batter comes to the plate with an initial count. ScorePAD allows you to set the initial count to any of the following counts:

- 0 Balls, 0 Strikes
- 1 Ball, 1 Strike
- 2 Balls, 2 Strikes
- 3 Balls, 2 Strikes

ScorePAD adds balls and strikes to bring each batter that comes to the plate to that initial count. You can change the initial count at any point during the game by returning to the Game Parameters dialog.
“Will ScorePAD allow a team to bat more than 9 players?”

Yes. ScorePAD allows up to 18 lineup players per team. Of course, this is not the roster size, which can be up to 60 players; the number of lineup players is the size of the batting order. This parameter can be set separately for each team in the game. The home team might have 10 lineup players while the visiting team has 12 lineup players. This feature is designed for youth baseball teams that allow everyone on the team to be a part of the batting order while only 9 players have defensive positions. Go to the Game Setup page and click Parameters.

“My team uses a designated hitter. How do I setup the lineup with a DH?”

When a team uses designated hitter (DH) that hitter bats in the place of a defensive player. In Major League Baseball that player is always the pitcher. Whenever either team in a game uses a DH, check this box and place the defensive player for which the DH bats in the last lineup slot. This will allow ScorePAD to gather defensive statistics for that player without placing him or her in the batting order.

When you've checked this checkbox, a lineup slot will appear at the end of the score card with no at-bat squares adjacent to it. You don't have to assign a DH when this box is checked.

“What is a ‘No Pitch’ and how do I record it?”

ScorePAD allows you to record a No Pitch by touching the N button. Fortunately, this rarely occurs. A no pitch happens when the pitcher attempts a pitch and for some reason, either the batter asked for time-out, the umpire was not ready, something or someone interfered, or for some other reason, the umpire calls "No pitch," and throws his hands up and forward. The pitch still adds to the pitch count but is not called a ball or a strike.

“How do I charge a dropped foul error?”

When a batter’s at-bat is extended due to an error in foul territory you can select AtBat from the GSP view and tap Charge dropped foul error. Then select the defensive position charged with the error and follow the prompts to complete the play. When finished it will bring you back to the current batter.
“How do I switch sides if the team has recorded less than three outs?”

When you press the Next button, ScorePAD moves to the next logical batter based on the game situation. After three outs, ScorePAD will move to the first logical batter on the opposing team.

In the case of maximum run rules or even the mutual agreement of the coaches and umpires, teams may switch sides in situations where there are less than three outs. In these situations, use the Switch Sides menu command. This GSP view menu command causes ScorePAD to immediately move to the next logical batter of the opposing team.

“How do I skip an at-bat?”

ScorePAD allows you to skip a batter. In games that use free substitution rules, players might leave the game leaving nine or more players in the lineup. Since you can't reduce the size of the lineup once you've gone through the entire lineup, ScorePAD allows you to skip that player's at-bat and score the next batter.

In cases where the team has eight batters, the ninth batter would probably not be skipped but counted as an out. In these cases, don't use Skip At-bat. Give that batter an out.

“Does ScorePAD handle the softball short fielder and extra hitter positions?”

Yes. ScorePAD provides a preference to include Short Fielder in its Defensive Positions Dialog. ScorePAD will also allow you to use zero (0) as the defensive position for Short Fielder in Graffiti play input. You should use short fielder as the defensive position of the fourth outfield position even when using the left-center and right-center outfield arrangements. To activate the Short Fielder, from the GSP view select Options>Preferences>Use Short Fielde Position. As for the extra hitter, you can simply have that player in the lineup without a position listed. This will allow them to participate offensively without accumulating defensive statistics.